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Printer Parts and Functions

Unpacking the Printer

Your printer box should include a CD-ROM containing printer
software that runs your printer, and the items shown in the
illustration.

In some locations, the power cord comes attached to the printer.
The shape of the AC plug varies by country; be sure the plug
included is the right shape for your location.

Remove all protective materials packed with your printer before
setting up and turning on the printer. Follow the instructions
inserted with the printer to remove these materials. Save all
packaging and protective materials for transporting the printer in
the future.

paper support

ink cartridges

printer
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Printer Parts and Control Panel Functions

sheet feeder

edge guides

output tray extension

output tray

printer cover

paper support

ink cartridge clamps

control panel

adjust lever

ink cartridge
replacement button

print head
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Buttons

Lights

Button Function

P
power

Turns the printer on and off.

Clears the printer's memory if pressed twice while the
power is on.

E
load/eject

Loads or ejects paper if pressed and released within
2 seconds.

Resumes printing if pressed and released after a paper
out error.

R
cleaning

Performs print head cleaning if held for 3 seconds when
the B black or A color ink out light is off.

Ink cartridge
replacement

Charges ink to the printer when you replace the ink
cartridges (this orange button is located under the
printer cover, not in the control panel).

Light Description

P
power

On when the printer is on.

Flashes when printer is receiving data, printing,
replacing an ink cartridge, charging ink, or cleaning
the print head.

S
paper out

On when the printer is out of paper. Load paper in the
sheet feeder, then press the E load/eject button to
resume printing.

Flashes when the paper is jammed. Take all of the
paper out of the feeder, then reload the paper. If the
light continues to flash, turn off the printer and gently
pull all the paper out of the printer.

B
black ink
out

Flashes when the black ink cartridge is nearly empty.

On when the black ink cartridge is empty. Replace the
black ink cartridge (T007) or (T010).

A
color ink
out

Flashes when the color ink cartridge is nearly empty.

On when the color ink cartridge is empty. Replace the
color ink cartridge (T008).
Printer Parts and Functions -3



-4 Printer Parts and Functions



Safety Instructions

Important Safety Instructions

Read all of these instructions before using your printer. Also be
sure to follow all warnings and instructions marked on the
printer.

❏ Do not block or cover the openings in the printer’s cabinet.
Do not insert objects through the slots.

❏ Take care not to spill liquid on the printer.

❏ Use only the type of power source indicated on the printer’s
label.

❏ Connect all equipment to properly grounded power outlets.
Avoid using outlets on the same circuit as photocopiers or air
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or
automatic timers.

❏ Keep the entire computer system away from potential sources
of electromagnetic interference, such as loudspeakers or the
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure the
total ampere rating of the devices plugged into the extension
cord does not exceed the cord’s ampere rating. Also, make
sure the total ampere rating of all devices plugged into the
wall outlet does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the printer yourself.
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❏ Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the
printer; the printer has been dropped or the cabinet damaged;
the printer does not operate normally or exhibits a distinct
change in performance.

A Few Precautions

When using the printer

❏ Do not put your hand inside the printer or touch the ink
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may
damage the printer.

❏ Always turn the printer off using the P power button. When
this button is pressed, the P power light flashes briefly then
goes off. Do not unplug the printer or turn off the power to
the outlet until the P power light stops flashing.

❏ Before transporting the printer, make sure the print head is in
the home (far right) position and the ink cartridges are in
place.

When handling the ink cartridges

❏ Keep ink cartridges out of the reach of children. Do not allow
children to drink from or otherwise handle the cartridges.
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❏ Be careful when you handle the used ink cartridges, as there
may be some ink around the ink supply port. If ink gets on
your skin, wash the area thoroughly with soap and water. If
ink gets in your eyes, flush them immediately with water. If
discomfort or vision problems remain after a thorough
flushing, see a doctor immediately.

❏ Do not shake an ink cartridge; this can cause leakage.

❏ Install the ink cartridge immediately after you remove it from
its package. If you leave a cartridge unpacked for a long time
before using it, normal printing may not be possible.

❏ Do not use an ink cartridge beyond the date printed on the
cartridge carton: otherwise, it may result in reduced print
quality. For best results, use up the ink cartridges within six
months of first installing them.

❏ Do not touch the green chip on the side of the cartridge. This
may inhibit normal operation and printing.

❏ Do not dismantle the ink cartridges. This could damage the
print head.

❏ After bringing an ink cartridge inside from a cold storage site,
allow it to warm up at room temperature for at least three
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ In this ink cartridge, the IC chip retains a variety of cartridge-
related information, such as the amount of ink remaining, so
that a cartridge may be removed and reinserted freely.
However, each time the cartridge is inserted, some ink is
consumed because the printer automatically performs a
reliability check.
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❏ If you remove an ink cartridge for later use, be sure to protect
the ink supply area from dirt and dust; store it in the same
environment as the printer. Note that there is a valve in the
ink supply port, making covers or plugs unnecessary, but care
is needed to prevent the ink from staining items that the
cartridge touches. Do not touch the ink cartridge ink supply
port or surrounding area.

When choosing a place for the printer

❏ Place the printer on a flat, stable surface that is larger than the
printer. The printer will not operate properly if it is tilted or
at an angle.

❏ Avoid places subject to rapid changes in temperature and
humidity. Also, keep the printer away from direct sunlight,
strong light, or heat sources.

❏ Avoid places subject to shocks and vibrations.

❏ Leave enough room around the printer to allow for sufficient
ventilation.

❏ Place the printer near a wall outlet where the plug can be
easily unplugged.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has
determined that this product meets the ENERGY
STAR guidelines for energy efficiency.

The International ENERGY STAR Office Equipment Program is
a voluntary partnership with the computer and office equipment
industry to promote the introduction of energy-efficient personal
computers, monitors, printers, fax machines, and copiers in an
effort to reduce air pollution caused by power generation.
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Warnings, Cautions, and Notes

w Warnings
must be followed carefully to avoid bodily injury.

c Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your
printer.
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Loading Plain Paper

Follow the steps below to load plain paper in the printer.

1. Lower the output tray and slide out the extension. Next, slide
the left edge guide so that the distance between the edge
guides is slightly wider than the width of your paper.

2. Fan a stack of paper, then tap it on a flat surface to even the
edges.

3. Load the stack of paper with the printable side up and the
right edge of the paper resting against the right side of the
sheet feeder. Then slide the left edge guide against the left
edge of the paper.

Note:
❏ Always load paper into the sheet feeder short edge first.

❏ Make sure the paper stack fits under the arrow mark inside the
edge guide.
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Loading Special Paper and Other Media

You can achieve good results with most types of plain bond paper.
However, coated paper and glossy film result in higher quality
printouts because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink
used in EPSON ink jet printers. EPSON recommends using media
distributed by EPSON to ensure high-quality results. See “EPSON
special media” on page 10-2 for a complete list of these products.

When loading special media distributed by EPSON, read the
instruction sheets packed with the media first and keep the
following points in mind.

❏ Make sure the printable side of the paper is facing up when
loading media into the sheet feeder. See the instruction sheets
packed with the media to determine which side is the
printable surface. Some media have cut corners to help
identify the correct loading direction, as shown in the
illustration.

Note:
If you extend the printable area by selecting the Maximum setting
in the printer driver, the cut corner on special paper may mar your
printout.

printable
side up

cut corner
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❏ Make sure the paper stack fits under the arrow mark located
on the inside surface of the left edge guide.
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❏ The loading capacity for EPSON special media is explained
below.

* Take care not to print on support sheets loaded under special media.

360 dpi Ink Jet Paper and
Photo Quality Ink Jet Paper

Up to the arrow mark on the left edge
guide.

Photo Quality Ink Jet Card,
Ink Jet Note Card, and Ink
Jet Greeting Card

Up to 30 index cards.
Always place the included support
sheet* under the cards.

Photo Quality Glossy Film One sheet at a time.
Always put a support sheet* or a sheet
of plain paper under the glossy film.
If you wish to load multiple sheets and,
load a maximum of 20 sheets for A4, set
the minimum top margin of the page to
30 mm.

Ink Jet Transparencies Up to 30 transparencies.
Always put a sheet of plain paper under
the stack of transparencies.

Photo Quality Self
Adhesive Sheet

One sheet at a time.

Photo Paper Up to 20 sheets.
For 200 × 300 mm Photo Paper, you can
only load one sheet at a time. Always
put a support sheet* under the stack of
Photo Paper.

Photo Stickers 16 and
Photo Stickers 4

One sheet at a time.
Always put the included support sheets*
A and B under the stack of Photo
Stickers.

Panoramic Photo Paper
and Iron-On Cool Peel
Transfer Paper

One sheet at a time.

Matte Paper-
Heavyweight

Up to 20 sheets.
Always put a support sheet* under the
stack of Matte Paper-Heavyweight.

Premium Glossy Photo
Paper

One sheet at a time.
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❏ When you are using Photo Quality Glossy Paper,
Transparencies, or Premium Glossy Photo Paper, remove
each sheet from the output tray as it is printed.

❏ If the paper is curled, make sure to flatten it or curl it slightly
toward the opposite side before loading. Printing on curled
paper may smear your printout, especially when printing
with Maximum selected as the Printable Area setting.

❏ If ink smears on your documents when printing on thick
media, set the adjust lever to the “+” position. To change the
setting, open the printer cover and position the lever as shown
in the illustration.

Note:
❏ Return the adjust lever to the “0” position before printing on

media of normal thickness. Leaving the lever in the “+” position
may cause gaps in the printed image.
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❏ When the adjust lever is in the “+” position, make sure the High
Speed setting in the printer driver’s Advanced dialog box is off.
To turn this option off, you may also need to change the Print
Quality setting or align the print head using the Print Head
Alignment utility.

If you wish to print on the reverse side of an Ink Jet Card with
Maximum selected as the Printable Area setting, flatten the
cards or curl them slightly toward the opposite side before
loading. Set the adjust lever to the “+” position before
printing.

About special media cleaning sheets

Cleaning sheets packaged with EPSON special media should not
be used with this printer. The cleaning function performed by
these sheets is not necessary with this type of printer, and the
sheets could jam in the printer.

Loading Envelopes

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes into the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the
total thickness of the stack of envelopes exceeds 10 mm, press each
envelope in the stack flat before loading.

❏ Set the adjust lever to the “+” position. To do this, open the
printer cover and reposition the lever.
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Note:
❏ Return the adjust lever to the “0” position, which is the normal

position, after you finish printing on envelopes. Leaving the
lever in the “+” position may cause gaps to appear in images
printed on other media.

❏ When the adjust lever is in the “+” position, make sure the High
Speed setting in the printer driver’s Advanced dialog box is off.
To turn this option off, you may also need to change the Print
Quality setting.

❏ Load envelopes flap edge first with the flap side down, as
shown in the illustration.

❏ Do not use envelopes that are curled or folded. Make sure to
flatten the envelope flaps before loading. Also avoid using
envelopes that are too thin; they may curl during printing.

❏ Select Plain Paper as the Media Type setting in the printer
driver.

Using EPSON Photo Paper (4 x 6 inch, 200 x 300 mm)

EPSON Photo Paper (S041134, S041254) is perforated around the
margins so you can trim your printed images to look like
4 × 6 inch (102 × 152 mm) or 200 × 300 mm photographs.

Available envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm
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Loading Photo Paper

Note the following when loading EPSON Photo Paper.

❏ Load the paper printable side up with the perforated margins
positioned as shown in the illustration.

❏ Use flat, undamaged paper. If the paper or the support sheet
is curled, flatten it before loading to avoid paper feeding
problems.

❏ Always place the included support sheet under the stack of
Photo Paper, but do not print on it.

❏ You can load up to 20 sheets of 4 × 6 inch Photo Paper or one
sheet of 200 × 300 mm Photo Paper into the sheet feeder.

❏ Do not fold the paper before printing.

❏ Cut or tear the paper at the perforation only after printing.

❏ Select Photo Paper as the Media Type setting and Photo
Paper 4 × 6 in or Photo Paper 200 × 300 mm as the Paper
Size setting in your printer driver.

loading position
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Removing the perforated margins

Note the following when removing the perforated margins.

❏ To remove the perforated margins, fold the paper back and
forth a few times along the perforations, then carefully tear
the margins off.

❏ You can also remove the margins by cutting along the
perforations.

Note:
Keep in mind that the edges of your image might be cut off when you
remove the perforated margins. See the illustrations below.
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4 x 6 inch

17 mm (0.67 in.)

trimmed size

printed image size

6 mm (0.24 in.)

3 mm 6 mm

3 mm (0.12 in.)
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200 x 300 mm

Storing EPSON Photo Paper

Keeps the following points in mind when storing Photo Paper.

❏ Return unused paper to the original package as soon as you
finish printing, and avoid storing it in places exposed to high
temperature, humidity, or direct sunlight.

❏ EPSON recommends storing your printouts in a resealable
plastic bag and keeping them away from high temperature,
humidity, and direct sunlight.

19 mm (0.75 in.)

trimmed size

printed image size
8 mm (0.31 in.)

5 mm 19 mm

5 mm (0.2 in.)
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Using EPSON Photo Paper (Roll Paper)

EPSON Photo Paper also comes in a roll paper format, which is
convenient for banner printing. EPSON recommends using the
optional Roll Paper Holder (C81111✽) to load roll paper into the
printer; however, it is possible to cut the roll paper to the
appropriate size and load each sheet into the printer’s sheet feeder
individually.

Whether you are printing using the optional Roll Paper Holder
or are printing on cut roll paper, keep the following in mind when
printing on this media.

❏ Load the paper printable side up.

❏ Use flat, undamaged paper. If the paper is curled, flatten it
before loading to avoid paper feeding problems.

❏ Always handle paper by the edges.

❏ Be sure to provide ample space in front of the printer.

❏ Make sure that the output tray is down, and the output tray
extension is closed.

❏ Check that the end of the paper is cut cleanly, perpendicular
to the long axis of the paper. If it is cut on a diagonal or not
cleanly, the paper may not feed smoothly or the print may
extend off the edge of the paper.

❏ EPSON recommends using media distributed by EPSON to
ensure high-quality results.

Using the Roll Paper Holder

You will need the optional Roll Paper Holder (C81111✽), sold
separately, to load roll paper into the printer in roll form.
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Preparing the roll of Photo Paper

Before printing, always prepare the paper as described below.

1. Check that the end of the roll is cut perpendicularly to the
edges as shown. If it is cut on a diagonal, recut it to be
perpendicular. For A4 and 329-mm width paper, cut along
the parallel lines on the back. For 89- and 100-mm width
paper, use a triangle.

c Caution:
Always use a triangle or other tool to ensure that the end of
the roll is cut perpendicularly. A diagonal cut may cause
paper feed problems.
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2. Roll the paper in the direction opposite of the paper’s curl so
that the curl disappears, as shown below. Use the protective
film packaged with the optional Roll Paper Holder, or a thin
booklet such as your Daily Use guide to roll the paper inside.

Loading the roll of Photo Paper

Follow the directions below to mount the optional Roll Paper
Holder and load the roll of Photo Paper.

1. Turn on the printer.
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2. Remove the paper support.

3. Mount the Roll Paper Holder by lowering it into the slot on
the back of the sheet feeder where the paper support was
mounted, as shown below.

Note:
Match the R and L markings on the Roll Paper Holder to those on
the printer.
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4. Slide the roll of Photo Paper onto the spindle, and make sure
the left and right of the Roll Paper Holder. Make sure that the
spindle is oriented correctly as shown in the illustration
below.

5. Gently insert the end of the paper into the printer, flush with
the right edge guide, as far as it will go. Slide the left edge
guide against the left edge of the paper.
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6. To load the roll paper, lightly hold the paper in place while
you press the E load/eject button. The paper feeds into the
printer.

Note:
You must hold the paper edge in place with your hand while you
press the E load/eject button to make sure the paper feeds correctly.

7. Open the printer cover and make sure that the paper is
feeding correctly. If it is not straight, press the E load/eject
button for three seconds to eject the paper, then feed the paper
again.

The roll paper is now loaded. Next, set up the printer driver and
try printing. For details on setting up the printer driver, refer to
“Printing on EPSON Photo Paper (roll paper)” on page 1-22.
1-18 Paper Handling



Using cut roll paper

You do not need the Roll Paper Holder to load roll paper.
However, if you are not using the holder, you must cut the paper
into sheets of the correct size before loading it into the sheet
feeder.

Preparing the roll paper sheets

Cut the roll paper into sheets as described below.

1. Cut the paper at least 34 mm longer than the length of the
printed data (we recommend that you add 50 mm or more to
the length of the print data).

Note:
If the paper length is less than the length of the paper plus 34 mm,
nothing will be printed on the last 14 mm of the paper.

For A4 and 329-mm width roll paper, lines are printed on the
back at 5-cm intervals, with bold lines printed at 50-cm
intervals. Always cut perpendicular to the edges, using these
lines as reference. Cut 89- and 100-mm width paper using a
triangle.
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c Caution:
Always use a triangle or other tool to ensure that the end of
the roll is cut perpendicularly. A diagonal cut may cause
paper feed problems.

2. Roll the paper in direction opposite of the paper’s curl so that
the curl disappears, as shown below. Use the protective film
packaged with the optional Roll Paper Holder, or a thin
booklet such as your Daily Use guide to roll the paper inside.

Loading a roll paper sheet

Follow the directions below to load a sheet of roll paper into the
printer.

1. Turn the printer on.
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2. Remove the paper support.

3. Load the paper into the sheet feeder and slide the left edge
guide against the left edge of the paper.
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4. To load the sheet in the printer, lightly hold the paper in place
while you press the E load/eject button, as shown below.
Once the sheet is loaded, you are ready to print.

Note:
❏ You must hold the paper edge in place with your hand while

you press the E load/eject button to make sure the paper feeds
correctly.

❏ If the paper does not feed correctly, remove the paper completely
and load it again. If you have difficulty removing the paper, hold
the E load/eject button for three seconds to eject it.

The roll paper sheet is now loaded in your printer. Next, set up
the printer driver and try printing. For details on setting up the
printer driver, refer to “Printing on EPSON Photo Paper (roll
paper)” on page 1-22.

Printing on EPSON Photo Paper (roll paper)

Once you have prepared your roll paper and loaded it into the
printer, you must make the printer driver settings before you can
print.
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One of the first things you should decide is what width of roll
paper you will be using. This will determine what Paper Source
setting you will need to make. Select Roll Paper as the Paper
Source in the printer driver if you are printing on A4 or 329-mm
width roll paper. If you are using 89- or 100-mm width roll paper,
select Roll Paper or Roll Paper [Zero Margins]. Refer to the table
below for details.

With Roll Paper selected as the Paper Source, a
3-mm margin will be left along both sides of the
paper. A 36-mm margin will be inserted between
print jobs.

In printing, the top margin above the print data
will be set to 20 mm.

When printing is done, press the E load/eject
button once to print a guide line for cutting about
12 mm from the bottom of the print data.

To print out the next page after pressing the E
load/eject button again, the space between the
two blocks of print data will be about 36 mm.

With Roll Paper selected as the Paper Source,
when printing data which spans multiple pages in
your application, a 3-mm margin will be left along
both sides of the paper. The margin between
pages will be set to 0, but the margin between
print jobs will remain 36 mm

With Roll Paper [zero margins] selected as the
Paper Source, no margin will be left along either
side of the paper. A 36-mm margin will be inserted
between print jobs.

In printing, the top margin above the print data
will be set to 20 mm.

The left and right margins will be set to 0 mm by
selecting Roll Paper [Zero Margins].

When printing is done, press the E load/eject
button once to print a guide line for cutting about
12 mm from the bottom of the print data.

To print out the next page after pressing the E
load/eject button again, the space between the
two blocks of print data will be about 36 mm.
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For Windows users

Note:
❏ When printing on roll paper, you cannot use the Reverse Order

or Rotate by 180° features, select Maximum or Centered as
the Printable Area setting, or use the functions on the Layout tab.

❏ Do not select PhotoEnhance in the printer driver, because it may
cause offsets in the print area at logical page boundaries.

After the roll paper is loaded in the printer, follow the steps below
to configure your driver for printing.

1. Open the file you wish to print.

2. Access the printer driver from the application.

Note:
For details on accessing the driver, refer to the application’s user
manual. In many applications, you can select Print directly from the
File menu and access the printer driver by clicking the Properties
button.

With Roll Paper [Zero Margins] selected as the
Paper Source, when printing data which spans
multiple pages in your application, no margin will
be left along either side of the paper. The margin
between pages will be set to 0, but the margin
between print jobs will remain 36 mm.
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3. Click the Paper tab and select the appropriate Paper Source
and Paper or Page Size.

Paper
Source

Roll Paper A 3-mm margin will be left on the right
and left sides of the paper.

RollPaper
[Zero
Margins]

Select this for 89-, and 100-mm width
roll paper. No left or right margins will
be left.

Paper size

Page Size

Select a predefined paper or page size from the list
or define a custom size.

If you select a predefined paper or page size, when
the data exceeds the selected size, it will be printed
in individual pages on the roll paper. A 36-mm margin
will be printed between each page of data in a print
job. When you press the E load/eject button.

Define a custom size by selecting User Defined in the
list. This will open the User Defined paper or page size
dialog box where you can specify the length and
width of your document. As long as your paper or
page size is large enough, the data will be printed as
one page. This will allow continuous printing of the
data without page breaks.
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Note:
Do not select Auto Sheet Feeder as the Paper Source setting in
the printer driver. Doing so will cause unnecessary paper to be fed
after each print job. If you accidentally select Auto Sheet Feeder,
cut the paper off at the back of the printer before it feeds into the sheet
feeder, then turn the printer power off and back on again.

4. Make the Roll Paper Option settings at the bottom of the
dialog box.

Banner Mode Select this mode when you wish to print multi-
page data as continuous data on the roll
paper, rather than as individual pages. When
this check box is selected, the Save roll paper
check box is enabled.

Cut Sheet Mode Select this mode when you wish to print the
multi-page data as individual pages, rather
than as continuous data. When this check box
is selected, the Print page frame check box is
enabled.

Save roll paper Select this check box when you do not wish
any paper to be fed after the data is printed.
This feature is only available when Banner
Mode is selected.

Print page frame Select this check box to print a line on the roll
paper between pages in a multi-page
document to indicate where the paper
should be cut. This feature is useful when it is
unclear where the page breaks should be or
where to cut the paper after the last page has
been printed. This feature is only available
when Cut Sheet Mode is selected.
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5. Click the Main tab, and select Photo Paper as the Media Type
setting.

6. Click OK to close the printer driver. Print your document and
proceed to the next section, “Removing the roll paper from
the printer” on page 1-30.

For Macintosh users

Note:
❏ The procedures described in this section may vary, depending upon

which application you are using. Check your application’s user
manuals for details.

❏ When printing on roll paper, you cannot use the Reverse Order
or Rotate by 180° features, select Maximum or Centered as
the Printable Area setting, or use the functions in the Layout dialog
box.

❏ Do not select PhotoEnhance in the printer driver, because it may
cause offsets in the print area at logical page boundaries.

After the roll paper is loaded in the printer, follow the steps below
to configure your driver for printing. Make sure that the Stylus
Photo 870 is selected in the Chooser before proceeding.

1. Open the file you wish to print.

2. Open the printer driver.
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Note:
In many applications, you can do this by selecting Page Setup (or
Print Setup) from the File menu.

3. Select the appropriate Paper Source and Paper Size. You can
select either a predefined paper size, or create a custom paper
size.

4. Make the other settings as necessary. Refer to the table below
for details. When finished, click OK.

Banner Mode Select this mode when you wish to print multi-
page data as continuous data on the roll
paper, rather than as individual pages. When
this check box is selected, the Save roll paper
check box is enabled.
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5. Select Print from the File menu to open the Print dialog box.

6. Select Photo Paper as the Media Type setting, then click the
Print button to print your document.

Cut Sheet Mode Select this mode when you wish to print the
multi-page data as individual pages, rather
than as continuous data. When this check
box is selected, the Print page frame check
box is enabled.

Save roll paper Select this check box when you do not wish
any paper to be fed after the data is printed.
This feature is only available when Banner
Mode is selected.

Print page frame Select this check box to print a line on the roll
paper between pages in a multi-page
document to indicate where the paper
should be cut. This feature is useful when it is
unclear where the page breaks should be or
where to cut the paper after the last page has
been printed. This feature is only available
when Cut Sheet Mode is selected.
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Note:
❏ Click Custom to display the specific printer menu for your

application, or to make detailed settings.

❏ Click the Preview icon button and the Print button will
change to a Preview button. Click the Preview button to see
a preview of the printout.

Removing the roll paper from the printer

After the print job is finished, press the E load/eject button; a line
will be printed on the roll paper indicating where to cut the paper.
Follow the directions below to remove the paper from the printer.

1. Press the E load/eject button to feed the paper so that you can
easily cut along the printed line. If you are printing on cut
sheets of roll paper which you wish to eject, press the E load/
eject button until the paper ejects.

Note:
❏ If you wish to print more data on the same sheet of paper, press

the E load/eject button and send the next print job. The paper
will return to the printing start position before printing again.

❏ You must press the E load/eject button; otherwise, the printer
will not operate even if you send a new print job. However, do
not press the E load/eject button more than is necessary;
repeated motion may damage the printout.
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2. Cut the paper along the printed line. Never pull the paper as
you cut it. Doing so may damage the printout. When cutting
the paper, do not cut inside the line (closer to the printer) as
this may cause paper feed problems.

Note:
EPSON recommends that you use a triangle or other tool to ensure
that the end of the roll is cut perpendicularly. A diagonal cut may
cause paper feed problems.

3. Once you have cut the paper, hold down the E load/eject
button for about 3 seconds.
The paper will feed in reverse to a position where it can be
easily removed from the sheet feeder at the back of the printer.
If it does not feed to this position, repeat this step.

4. Gently remove the paper.

Your document has now been printed.

Storing EPSON Photo Paper (roll paper)

Keeps the following points in mind when storing roll paper.

❏ Return unused paper to the original package as soon as you
finish printing, and avoid storing it in places exposed to high
temperature, humidity, or direct sunlight.

❏ EPSON recommends storing your printouts in a resealable
plastic bag and keeping them away from high temperature,
humidity, and direct sunlight.
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Chapter 2

Using the Printer Software for Windows
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Printer Software Introduction

The printer software which comes with your printer includes a
printer driver and printer utilities. The printer driver lets you
choose from a wide variety of settings to get the best results from
your printer. The printer utilities help you check the printer and
keep it in top condition.

Getting more information

For information on using the printer driver, see “Making Changes
to Printer Settings” on page 2-4.

For information on using the printer utilities, see “Using the
Printer Utilities” on page 2-28.

Note:
The specific features available in the printer software vary depending on
the version of Windows you are using.

Online help provides more information about the printer
software. See “Getting Information Through Online Help” on
page 2-35 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows
applications, or from the Windows Start menu (Windows 95, 98
and NT 4.0).

When you access the printer software from a Windows
application, the settings you make apply only to the application
you are using.

When you access the printer software from the Start menu, the
settings you make apply to all of your Windows applications.
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From Windows applications

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options,
or Properties. (Depending on your application, you may need
to click a combination of these buttons.) The printer driver
opens.

From the Windows Start menu

1. Click Start, point to Settings, then click Printers.

2. For Windows 95 and 98, select your printer, then click
Properties on the File menu. For Windows NT 4.0, select your
printer, then click Document Defaults on the File menu. The
printer driver opens.

Making Changes to Printer Settings

The printer driver features the following menus and settings.

The Mode settings on the Main menu are arranged to give you
four levels of control over the printer driver, as explained below.

Main: Media Type, Ink, Mode

Paper: Paper Size, Copies, Orientation,
Paper Source, Printable Area

Layout: Reduce/Enlarge, Multi-Page, Watermark

Automatic This mode provides the quickest and
easiest way to start printing. See “Using
the Automatic mode” on page 2-8.

PhotoEnhance This mode lets you choose from a variety
of image-correction settings specially
designed for photos. See “Using the
PhotoEnhance mode” on page 2-9.
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In addition to making comprehensive Mode settings that affect
overall print quality, you can also modify individual aspects of
your printout using the Paper and Layout menus. See “Modifying
the printout style” on page 2-14.

Making the Media Type setting

The Media Type setting determines what other settings are
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches
the media which is loaded in the printer. To find out what Media
Type you are using, find your media in the list below, and refer
to the corresponding Media Type under which it is grouped
(shown in larger type). For some media, there are several Media
Type settings to choose from.

Custom This mode lets you choose from a list of
ready-made or personalized settings
suited to the kind of document you want
to print. When Custom is selected, the
Advanced button is enabled, allowing
you to access the Advanced dialog box.
See “Using the Custom mode” on page
2-10.

Advanced This button opens the Advanced dialog
box, where you can make detailed
settings to fit your individual needs. From
the Advanced dialog box, you can add
your personalized settings to the Custom
Settings list. See “Using the Advanced
settings” on page 2-11.
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Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes) S041148

EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes) S041149
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Matte Paper-Heavyweight

Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Matte Paper-Heavyweight (A4) S041259

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (89mm × 7M) S041301

EPSON Photo Paper (100mm × 8M) S041302

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Premium Glossy Photo Paper (A4) S041297
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Using the Automatic mode

When Automatic is selected as the Mode setting on the Main
menu, the printer driver takes care of all detailed settings based
on the current Media Type and Ink settings. To make the Ink
setting, click Color to print in color, or Black to print in black-
and-white or grayscale. To make the Media Type setting, see
“Making the Media Type setting” on page 2-5.

Note:
❏ Depending on the media selected in the Media Type list (while

Automatic is selected), a slider appears under the Custom radio
button that lets you choose from Quality or Speed settings. Select
Quality when print quality is more important than speed.

❏ Most Windows applications feature paper size and page layout
settings that override similar settings on the printer driver.
However, if your application does not have these settings, verify the
settings on the printer driver’s Paper menu.
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Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction
settings that you can apply to your photo images before printing.
PhotoEnhance does not affect your original data.

Note:
❏ This mode is only available only when printing 32-bit color data.

❏ Printing with PhotoEnhance selected may increase the time
required for printing, depending on your computer system and the
amount of data contained in your image.

❏ Do not print using PhotoEnhance mode if Roll Paper is selected
as the Paper Source on the Paper menu.

You can select from the following settings.

Standard This setting provides standard image correction for
most photos. Try this first.

People This setting is best for photos of people.
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Selecting PhotoEnhance also enables the Digital Camera
Correction check box. Select this check box when you are
printing photos taken with a digital camera to give your printed
images the smooth, natural appearance of photographs taken
with a film camera.

Using the Custom mode

The Custom mode offers ready-made settings designed for
printing text and graphs and for applying a color-matching
method. You can also create and save your own custom settings.
See “Using the Advanced settings” on page 2-11 for details.

Nature This setting is best for outdoor scenery such as
mountains, sky, and oceans.

Soft Focus This setting makes your photos look as if they were
taken with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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You can select from the following ready-made settings.

Follow the steps below to select a Custom setting.

1. Select Custom as the Mode setting on the Main menu.

2. Click anywhere in the list box to open it, then select the most
appropriate setting for the type of document or image you
wish to print.

3. When you select a Custom setting, other settings such as Print
Quality, Halftoning, and Color Adjustment are made
automatically. Changes to these settings are reflected in the
display on the left side of the Main menu.

4. Before printing, be sure to verify the Media Type and Ink
settings, as they may be affected by the Custom setting you
select. See “Making the Media Type setting” on page 2-5.

Using the Advanced settings

The settings in the Advanced dialog box give you complete
control over your printing environment. Use these settings to
experiment with new printing ideas, or to fine-tune a range of
print settings to meet your individual needs. Once you are
satisfied with your new settings, you can give them a name and
add them to the Custom Settings list on the Main menu.

Text/Graph This setting is good for printing
presentation documents such as graphs
and charts.

Economy This setting is best for printing drafts of text

ICM

(For Windows 95 and
98)

This setting automatically adjusts printout
colors to match colors on your screen.
ICM stands for Image Color Matching.

sRGB This setting is best for color matching with
other sRGB devices.
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Making Advanced settings

Follow the instructions below to make Advanced settings.

Note:
The printer driver screens that appear in this procedure are for
Windows 95 and 98. The Windows NT 4.0 printer driver screens differ
only slightly.

1. Select Custom as the Mode setting on the Main menu and
then click Advanced. The following dialog box appears.

2. Select the Media Type you loaded in the printer. For details,
see “Making the Media Type setting” on page 2-5.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.
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Note:
❏ The PhotoEnhance option under Color Management only

affects images, not text or graphs. For example, if
Monochrome is selected from the Tone list (enabled when
PhotoEnhance is selected), only the images in a document
will be printed in monochrome. Any colored text or graphs in
the same document will be printed in color.

❏ Some settings may be unavailable depending on the Media
Type, Ink, and Print Quality settings you make.

6. Click OK to apply your settings and return to the Main menu.
If you want to return to the Main menu without applying your
settings, click Cancel. To save your Advanced settings, see
the next section.

Saving and deleting your settings

To save your Advanced settings in the Custom Settings list, click
Save Settings in the Advanced dialog box. The Custom Settings
dialog box appears.
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Type a unique name for your settings in the Name box, then click
Save. Your Advanced settings will be added to the Custom
Settings list.

Note:
❏ You cannot apply the names of settings provided by EPSON to your

custom settings.

❏ You cannot delete the ready-made settings from the Custom Settings
list.

To delete a setting from the Custom Settings list, select the setting
name in the Custom Settings dialog box and click Delete.

Using your saved settings

To select your settings, click the Custom button on the Main
menu, then select your setting in the Custom Settings list, located
to the right of the Custom button.

If you change the Media Type or Ink settings when one of your
customized settings is selected in the Custom Settings list, the
selection shown in the list returns to Custom Settings. The
customized setting that was previously selected is not affected by
the change. To return to your customized setting, simply reselect
it in the list.

Modifying the printout style

You can modify your printout style using a variety of printer
driver settings located on the Paper and Layout menus.

On the Paper menu, you can set the paper size, the number of
copies, the orientation of your printout, and the printable area.
On the Layout menu, you can automatically match the document
size to the paper size, print two or four pages on a single sheet of
paper, print poster-size images by enlarging one page to cover
several sheets, or place watermarks on documents.
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Note:
Layout menu is enabled only when you select Auto Sheet Feeder as
a Paper Source in the Paper menu.

Making the Paper settings

Use the settings on the Paper menu to change the paper size, set
the number of copies and other copy parameters, specify the
paper orientation, and adjust the printable area.

The settings which are available vary depending upon whether
Auto Sheet Feeder or one of the roll paper options is selected as
the Paper Source.

When you select Auto Sheet Feeder as the Paper Source, the
driver will appear as shown below.
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When you select either roll paper option as the Paper Source, the
driver will appear as shown here.

You can make the following settings on the Paper menu:

Paper Source Select the paper source you wish to use from the
following selections.

Auto Sheet Feeder:
Select this when printing on normal paper.

Roll Paper:
Select this when printing on roll paper. This leaves a
3 mm margin on both the right and the left sides of
the roll paper while the document prints.

Roll Paper [Zero Margins]:
Select this only when printing on roll paper which is
89 or 100 mm in width. This eliminates the margins on
both sides of the roll paper while the document
prints.

Paper size

Page Size

Select the paper or page size you want to use. You
can also add a custom paper size.
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Copies Select the number of copies you wish to print. You
can select Collate to print one set at a time or
Reverse Order to determine the order in which you
print multiple copies of your document.

Orientation Select Portrait (tall) or Landscape (wide) to change
the orientation of your printout. If you need to print
closer to the bottom of the page, select the Rotate
by 180° check box.

Printable Area Use the options in the Printable Area box to adjust
the total area available for printing when Auto Sheet
Feeder is selected as the paper source. This feature
is not available when Roll Paper or Roll Paper [Zero
Margins] is selected.

If you want to center the printout, select Center. If
you need to increase the printable area, select
Maximum. Do not select Maximum when using
Premium Glossy Photo Paper.

Note:
When Maximum is selected, the print quality may
decline at the edges of the printout. Before printing
large jobs using this setting, print a single sheet to
confirm quality.
When Maximum is selected, make sure the paper
loaded in the sheet feeder is not curled.
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Roll Paper
Option

The Roll Paper Option settings are only available
when Roll Paper or Roll Paper [Zero Margins] is
selected as the paper source. These features are not
available when Auto Sheet Feeder is selected.

The settings are as follows:

Banner Mode:
Select this mode when you wish to print multi-page
data as continuous data on the roll paper, rather
than as individual pages. When this check box is
selected, the Save roll paper check box is enabled.

Cut Sheet Mode:
Select this mode when you wish to print the multi-
page data as individual pages, rather than as
continuous data. When this check box is selected,
the Print page frame check box is enabled.

Save roll paper:
Select this check box when you wish to save roll
paper. When this check box is selected, the blank
portion of the last page of your document is not fed
through the printer. This feature is only available
when Banner Mode is selected.

Print page frame:
Select this check box to print a line on the roll paper
between pages in a multi-page document to
indicate where the paper should be cut. This feature
is useful when it is unclear where the page breaks
should be. This feature is only available when Cut
Sheet Mode is selected.
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Fitting your document to the paper size

Use the Reduce/Enlarge options on the Layout menu to fit your
document to the paper size you will print on.

You can select from the following settings.

Normal Prints your document at its normal size.

Fit to Page Proportionally enlarges or reduces the size of
your document to make it fit the paper size you
select in the Paper Size list on the Paper menu.

Custom Allows you to manually reduce or enlarge an
image. Click the arrows next to the Scale to
box to select a percentage between 10% and
400%.
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Printing two or four pages on one sheet

Select N-up as the Multi-Page setting on the Layout menu to print
two or four pages of your document on one sheet of paper.

To print more than one page on the piece of paper, you should
make the following settings:

2 Pages
4 Pages

Prints two or four pages of your document on
a single piece of paper.

Page Order Opens the Print Layout dialog box, where you
can specify the order in which the pages will
be printed on the sheet of paper. Some
settings may be unavailable, depending upon
your Orientation selection on the Paper menu.

Print page
frames

Allows you to print a frame around each page
that is printed on the sheet of paper.
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Printing posters

A single document page can be enlarged to cover 4, 9, or 16
printed sheets of paper. Select Poster as the Multi-Page setting to
print a poster-size image.

Click the Settings button to adjust the way your poster will print.
The Poster Settings dialog box opens.
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You can make the following settings.

If you only want to print a few of the panels without printing the
entire poster, click the panels you don’t wish to print, then click
OK to close the Poster Settings dialog box.

Printing a watermark on your document

To print a watermark on your document, click anywhere in the
Watermark list box on the Layout menu to open it, and select from
the list of predefined watermarks.

You can also add your own text-based or image-based
watermarks to the Watermark list. Follow the steps below.

Overlapping
Panels

Slightly overlaps the images so that they can be
aligned more precisely.

Print Cutting
Guidelines

Prints border lines on the images to guide you
when trimming the pages.
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Click the Add/Del button. The following dialog box appears.

Creating an image-based watermark:

1. Select BMP.

2. Click the Browse button to specify the bitmap file you want
to use, then click OK.

3. Type a name for your watermark in the Name box, then click
Save.

Creating a text-based watermark:

1. Select Text.

2. Type your text in the Text box. The text that you enter will
also be assigned to the watermark as a watermark name.

3. If you want to change the watermark name, type a new name
in the Name box, then click Save. Click OK to return to the
Layout menu.
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Making settings for your watermark:

1. Click the Settings button. The following dialog box appears.

2. From the Watermark list box, select the watermark you want
to make settings for, then make Color, Position, Density, Size,
Font, Font Style and Angle settings. For details, please see the
online help. Your settings are reflected in the display on the
left side of the dialog box.

3. When you are finished making the settings, click OK.
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Previewing your printout

Select the Print Preview check box on the Main menu to see a
preview of your document before printing.
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When you print your document, the Print Preview window
opens.

The Preview dialog box contains several icon buttons which you
can use to perform the following functions:

Drag ’n’ Drop This feature let you select and move
watermarks.

Zoom This feature enlarges or reduces the size
of the previewed page.

Fit-to-screen This feature scales the previewed page
so that it fits the size of the window.
Select this option if you want to see the
entire page at one time.

Maximum
zoom

This feature displays the previewed
page at the maximum possible zoom
ratio.

Printable
area on/off

This feature displays a rectangle on the
page being previewed. This rectangle is
the printable area for the page. The
printer cannot print anything which
exceeds this rectangle. Press the icon
button again to turn this feature off.
2-26 Using the Printer Software for Windows



You can also manipulate the previewed document in the
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages.

❏ Apply watermarks. The watermark you select will appear in
the previewed image. For detailed information on
customizing watermarks, see “Printing a watermark on your
document” on page 2-22.

❏ The Add and Remove features allow you to specify which
pages in the document you wish to be printed. To add or
remove a page, you must first click the page icon in the list
appearing on the left side of the preview window. Then add
or remove it using the commands in the Print Options menu.

Watermark This feature opens the watermark
settings dialog box. This dialog box
allows you to change any of the current
watermark settings.

Reset
watermark
settings

This feature returns all watermark
settings to what they were when the
Preview was first opened. If nothing has
been changed, this feature is not
available.

Previous
page

This feature displays the page previous
to the one currently being previewed. If
there is no previous page then this
feature is not available.

Next page This feature displays the next page in the
document. If there is no next page then
this feature is not available.

Add page The highlighted pages will be added to
the list of pages to be printed.

Remove
page

The highlighted pages will be removed
from the list of pages to be printed.
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After you have previewed the document, click Print to print the
document, or click Cancel to cancel printing.

Using the Printer Utilities

EPSON printer utilities allow you to check the current printer
status and to perform some printer maintenance from your
computer screen. For Windows 95, 98 and NT 4.0, utilities to check
the current printer status are also available.

To use the utilities, click the Utility tab in the printer software
window, then click the button for the utility you wish to use. For
information on how to access the printer software, see “Accessing
the printer software” on page 2-3.

Note:
❏ The letter in parentheses after the utility name indicates the shortcut

key for that utility. Press Alt and the letter on the keyboard to open
that utility.
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❏ Do not use the Nozzle Check, Head Cleaning, and Print Head
Alignment utilities with printers connected to your computer
through a network.

❏ Do not use the Nozzle Check, Head Cleaning, and Print Head
Alignment utilities while printing is in progress; otherwise, your
printout may be marred.

Status Monitor 3

Status Monitor 3 provides you with printer status information,
such as the amount of ink remaining, and checks for printer errors.

This utility is only available both of the following conditions are
met:

❏ The printer is connected directly to the host computer via the
parallel port or the USB port.

❏ Your system is configured to support bidirectional
communication.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for
clogging. Check the nozzles if you notice print quality has
declined and after cleaning to confirm that the print head nozzles
have been cleared. If the nozzle check indicates the print head
needs cleaning, you can access the Head Cleaning utility directly
from the Nozzle Check utility. See “Checking the Print Head
Nozzles” on page 8-2.
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Head Cleaning

The Head Cleaning utility cleans the print head. You may need
to clean the print head when you notice print quality has declined.
Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. You can access the Nozzle Check utility
directly from the Head Cleaning utility. See “Cleaning the Print
Head” on page 8-4.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this
utility if you notice a misalignment of vertical lines. Follow the
on-screen instructions to use this utility.

Printer and Option Information

This utility allows the printer driver to confirm printer
configuration information. It also provides specific information
regarding certain characteristics of the printer, such as the Printer
ID.
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Depending on the configuration of your system, the information
displayed in the Printer and Option Information dialog box may
be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting
you to enter settings, or if you change the printer configuration,
follow the steps below to make the necessary settings manually.

1. Click the Settings Sheet button in the Printer and Option
Information dialog box to print out information about your
printer and options. This requires that A4 or Letter size paper
is loaded in your printer. You will see a printout similar to the
one below.

2. Make sure the settings in the utility match the information on
the printed Settings Sheet. If they do not match, correct the
settings on the screen to match the information on the settings
sheet.

3. Click OK to exit this menu and save your settings.
Using the Printer Software for Windows 2-31



Speed & Progress

You can make settings related to print speed and progress in this
dialog box.

The available settings are as follows.

High Speed Copies

To print multiple copies of your document faster, select High
Speed Copies.

Show Progress Meter

To monitor the progress of your print job, select Show Progress
Meter.

EPSON Printer Port (For Windows 95 and 98 only)

To speed up the data transfer rate to EPSON printers, select
EPSON Printer Port.
2-32 Using the Printer Software for Windows



If your computer supports ECP mode, enable DMA transfer to
speed up printing.

For more details, see “Using Speed & Progress” on page 2-38.

Note:
You cannot make this settting if your printer is connected with USB
port.

Always Spool Raw Datatype (For Windows NT only)

Select this check box to have Windows NT-based clients spool
documents using the RAW format instead of the EMF (metafile)
format (Windows NT-based applications use the EMF format by
default).

Try using this option if documents spooled in EMF format do not
print correctly.

Spooling RAW datatype requires less resources than EMF, so
some of problems (“Insufficient Memory/Disk Space to Print”,
“Slow print speed”, etc.) can be solved by selecting the “Always
spool RAW datatype” check box.

When spooling RAW datatype, print progress as displayed by the
Progress Meter may differ from actual print progress.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box
where you can make settings for EPSON Status Monitor 3. The
settings are described in detail in the next section.
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Monitoring Preferences

When you click the Monitoring Preferences button, the
following dialog box appears.

You can make the following settings:

Select
Notification

Displays the current error item notification settings.

Select the appropriate check boxes to specify the error
types for which you wish to receive notification.

Select
Shortcut
Icon

Select the Shortcut Icon check box to have a shortcut
icon placed in your Windows taskbar. Clicking the
shortcut icon in the taskbar will open EPSON Status
Monitor 3. To select which icon will be displayed, click
the icon your prefer from the choices given; your
selection will be shown at the right.

Allow
monitoring
of shared
printers

When this check box is selected, a shared printer can
be monitored by other PCs.
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Note:
Click the Default button to revert all Select Notification settings to their
defaults.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which
provides you with instructions on printing, making printer driver
settings, and using printer utilities.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then click
Printer, Setup, Options, or Properties. (Depending on your
application, you may need to click a combination of these
buttons.) Click Help at the bottom of the Main, Paper, Layout, and
Utility menus for help related to the items on that menu.

For Windows 95, 98, and NT 4.0, you can get specific help related
to any item on a menu by right-clicking the item, then clicking the
What's This? command.

Accessing help from the Windows Start menu

Click the Start button, point to Programs and Epson (for
Windows 95 and 98) or EPSON Printers (for Windows NT 4.0),
then click EPSON Stylus Photo 870 Help. The help contents
window opens.

Increasing the Print Speed

Follow the instructions in this section to increase the printing
speed of your printer.
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General tips

Just as printing at a high resolution requires more processing
time, printing in color takes longer than printing in black because
the volume of data in a color document is much greater. For this
reason, it is important to be selective in your use of color if you
also require a fast print speed.

However, even if your document requires the highest resolution
and extensive use of color, for example when you are printing a
camera-ready composite that includes color photographs, it may
still be possible to optimize the print speed by adjusting other
printing conditions. Keep in mind that changing some conditions
to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Setting
menu

Printer driver
settings

Print Quality Economy,
Normal

Photo Advanced
dialog box

High Speed On Off

Halftoning High
Speed
Halftoning

High
Quality
Halftoning

Finest Detail Off On

Data
characteristics

Image size Small Large –

Resolution Low High
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The table below shows the factors related to print speed only.

* Varies depending on the printer driver and application software you are
using.

** Grayscale means using black ink only to print varying shades of gray, from
pure black to pure white.

Print speed Faster Slower Setting
menu

Printer driver
settings

Ink Black Color Advanced
dialog box,
Main menu

Flip
Horizontal*

Off On Advanced
dialog box

Collate* Off On Paper
menu

Reverse
Order*

Off On

Data
characteristics

Variety of
colors

Grayscale** Full color –

Hardware
resources

System speed Faster Slower –

HDD free
space

Large Small

Memory free
space

Large Small

Software status Running
applicaations

One Many –

Virtual
memory

Not in use In use
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Using Speed & Progress

You can make certain print speed settings in the Speed & Progress
dialog box. Click the Speed & Progress button on your printer
software’s Utility menu. The following dialog box appears.

High Speed Copies

Select this check box to turn on high-speed printing for multiple
copies. This speeds up printing by using your hard disk space as
a cache when printing multiple copies of your document.

EPSON Printer Port (For Windows 95 and 98 only)

Select this check box to enable the EPSON printer port, which is
optimized for EPSON printers, instead of the Windows default
printer port. This speeds up the data transfer rate to EPSON
printers.

Note:
You cannot make this settting if your printer is connected with USB
port.
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Use DMA transfer (for Windows 95 and 98 only)

If your computer has a parallel port which supports ECP mode,
you can enable DMA transfer to speed up printing. See your
computer manual to determine if it supports ECP mode and DMA
transfer.

To determine whether you need to enable DMA transfer, compare
the message below the EPSON Printer Port check box to this table,
and take the recommended action.

If you need to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop, then
double-click Control Panel.

2. Double-click the System icon and click the Device Manager
tab.

Message Action

High Speed (DMA)
Transfer enabled.

DMA transfer is already enabled. Click OK
to close the dialog box.

For higher data transfer
rates, use DMA Transfer.

Follow the steps below this table to enable
DMA transfer.

(No message) Your system's parallel port setting does not
allow DMA transfer. However, if you
change the parallel port setting to ECP or
Enhanced using your computer's BIOS
Setup program, you may be able to use
DMA transfer. Consult your computer
manual or computer manufacturer for
instructions. Once you change the
parallel port setting, follow the steps
below this table to enable DMA transfer.

Note:
Before you run the BIOS Setup program,
uninstall the printer driver using Add/
Remove Programs in the Control Panel.
After running the BIOS Setup program,
reinstall the printer driver.
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3. Double-click the Ports (COM & LPT) icon and double-click
LPT1. If you have connected your printer to a port other than
LPT1, double-click the appropriate port icon.

4. Click the Resources tab, then clear the Use automatic
settings check box. Write down the Input/Output Range
settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on
list that uses the same Input/Output Range settings as those
you wrote down in Step 4, and make sure the Direct Memory
Access channel and Interrupt Request numbers are allocated
and displayed. Confirm also that the Conflicting device list
box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether
DMA transfer has been enabled.
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Note:
You may not be able to use DMA transfer on some computers even after
you make the settings explained above. Consult your computer maker
for information on the DMA transfer capability of your computer.

Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings for Windows NT 4.0 are complicated and should only be
made by an experienced person with administrative privileges.

If your computer has a parallel port that supports ECP mode, you
can make certain print speed settings in the Port Configuration
dialog box. Before making settings, make sure that ECP mode has
been selected in your computer settings. For details about ECP
mode, see your computer manual.

To access the Port Configuration dialog box, click the Start button,
point to Settings, and click Printers. Then select your printer and
click Properties on the File menu. The printer driver opens. Click
the Ports tab, then click Configure Port. The following dialog box
appears.
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Click the LPT port tab for the port to which your printer is
connected, then click the Port Configuration button.

Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

Resources Settings (IRQ and DMA)

If you have connected your printer to LPT2 or LPT3, making IRQ
and DMA settings here may speed up printing. Input the same
configuration numbers for IRQ and DMA which you have made
with your expansion board. See your computer documentation to
determine the settings for IRQ and DMA.

Use DMA transfer

Using DMA transfer to send print data to the computer may help
you speed up printing. If the Use DMA Transfer check box is not
available, you must first enable DMA transfer in your computer
settings. For details, see your computer documentation.
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Using the Progress Meter

When you send a print job to the printer, the Progress Meter
opens, as shown in the illustration below.

The Progress Meter indicates the progress of the current print job
and provides printer status information when bidirectional
communication between the printer and computer is established.
This meter also displays helpful tips for better printing and error
messages, as explained below.

Note:
The Progress Meter does not appear when the Show Progress Meter
setting is turned off in the Speed & Progress dialog box. See “Speed &
Progress” on page 2-32 for more information.

Epson Printing Tips

Tips for getting the most out of your EPSON printer driver appear
in the text box at the bottom of the Progress Meter window. A new
tip appears every 30 seconds. For more details on a tip which is
currently displayed, click the Details button.
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Error messages

If a problem occurs during printing, an error message appears in
the text box at the top of the Progress Meter window. When the
ink runs low or out, a How to button appears below the text box.
Click How To and EPSON Status Monitor 3 will lead you step-by-
step through the cartridge replacement procedure.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If
it receives two or more print jobs at one time, it holds them in the
order that they were received (with printers on a network this
may be called a print queue). When a print job reaches the top of
the line, the EPSON Spool Manager sends the job to the printer.

Note:
EPSON Spool Manager is not available for Windows NT.
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After you send a print job, an EPSON Stylus Photo 870 button
appears on the taskbar. Click this button to open the EPSON Spool
Manager. From the Spool Manager, you can view print status
information about the print jobs which have been sent to your
printer. You can also cancel, pause and resume, or restart selected
print jobs.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the
printer status.

Note:
Before using EPSON Status Monitor 3, be sure to read its README
file. To open this file, click Start, point to Programs and then EPSON
or EPSON Printers, then click EPSON Stylus Photo 870 Readme.

Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3.

❏ Double-click the printer-shaped shortcut icon on the
Windows taskbar. To add a shortcut icon to the taskbar, see
“Monitoring Preferences” on page 2-34.

❏ Open the printer driver, click the Utility tab, then click EPSON
Status Monitor 3.
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When you access EPSON Status Monitor 3, the following window
appears.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information:

❏ Current Status:
EPSON Status Monitor 3 provides you with detailed printer
status information, a graphic display, and status messages. If
the ink runs low or out, the How to button appears in the
EPSON Status Monitor 3 window. Clicking How to displays
cartridge replacement instructions and moves the print head
to the cartridge replacement position.

❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the
amount of ink remaining.

Note:
When you install a Light Capacity ink cartridge, the Ink Level display
will show that the cartridge is only half full. This is because a Light
Capacity ink cartridge only contains half of the amount of ink as a regular
cartridge.
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Printer Software Introduction

The printer software which comes with your printer includes a
printer driver and printer utilities. The printer driver lets you
choose from a wide variety of settings to get the best results from
your printer. The printer utilities help you check the printer and
keep it in top condition.

For information on using the printer driver, see “Making Changes
to Printer Settings” on page 4-2.

For information on using the printer utilities, see “Using the
Printer Utilities” on page 4-25.

You can also get more information about the printer software by
clicking the help icon in any of the dialog boxes in the printer
driver.

Making Changes to Printer Settings

You will find the printer driver settings in the following dialog
boxes.

❏ Print dialog box (click Print on the File menu of your
application or click Options in the Page Setup dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of
your application)

❏ Layout dialog box (click the Layout icon button in the Print
dialog box)

❏ Background Printing dialog box (click the Background
Printing icon button located in the Print dialog box)

❏ Preview dialog box (click the Preview icon button and then
click Preview in the Print dialog box)
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The Mode settings in the Print dialog box are arranged to give you
four levels of control over the printer driver, as explained below.

In addition to making comprehensive Mode settings that affect
overall print quality, you can also modify individual aspects of
your printout using the settings contained in the Page Setup and
the Layout dialog boxes. For information on page setup options,
see “Changing the page setup” on page 4-11. For information on
page layout options, see “Modifying the page layout” on page
4-17.

Making the Media Type setting

The Media Type setting determines what other settings are
available, so you should always make this setting first.

Automatic This mode provides the quickest and
easiest way to start printing. See “Using
the Automatic mode” on page 4-6.

PhotoEnhance This mode lets you choose from a variety
of image-correction settings specially
designed for photos. See “Using the
PhotoEnhance mode” on page 4-6.

Custom This mode lets you choose from a list of
ready-made or personalized settings
suited to the kind of document you want
to print. When Custom is selected, the
Advanced button is enabled, allowing
you to access the Advanced dialog box.
See “Using the Custom mode” on page
4-8.

Advanced This button opens the Advanced dialog
box, where you can make detailed
settings to fit your individual needs. From
the Advanced dialog box, you can add
your personalized settings to the Custom
Settings list. See “Using the Advanced
settings” on page 4-9.
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In the Print dialog box, select the Media Type setting that matches
the paper you loaded in the printer. To find out what Media Type
you are using, find your media in the list below, and refer to the
corresponding Media Type under which it is grouped (shown in
larger type). For some media, there are several Media Type
settings to choose from.

Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes) S041148

EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes) S041149
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Matte Paper-Heavyweight

Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Matte Paper-Heavyweight (A4) S041259

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (89mm × 7M) S041301

EPSON Photo Paper (100mm × 8M) S041302

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Premium Glossy Photo Paper (A4) S041297
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Using the Automatic mode

When Automatic is selected as the Mode setting in the Print dialog
box, the printer driver takes care of all detailed settings based on
the current Media Type and Ink settings. To make the Ink setting,
click Color to print in color, or Black to print in black-and-white
or grayscale. To make the Media Type setting, see “Making the
Media Type setting” on page 4-3.

Note:
Depending on the media you choose in the Media Type list (while
Automatic is selected), a slider appears to the right of the Mode options
that lets you choose Quality, Speed or an intermediate setting. Select
Quality when print quality is more important than speed.

Using the PhotoEnhance mode

The Photo Enhance mode provides a variety of image-correction
settings that you can apply to your photo images before printing.
PhotoEnhance does not affect your original data.
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Note:
❏ This mode is only available when printing 32-bit color data.

❏ Printing with PhotoEnhance selected may increase the time required
for printing, depending on your computer system and the amount
of data contained in your image.

❏ If you select Roll Paper as a Paper Source in the Page Setup dialog
box, do not print your document with the PhotoEnhance mode on.

You can select from the following settings.

If you are printing photos taken with a digital camera, you can
also select the Digital Camera Correction check box to give your
printed images the smooth, natural appearance of photographs
taken with a film camera.

Standard This setting provides standard image correction for
most photos. Try this first.

People This setting is best for photos of people.

Nature This setting is best for outdoor scenery such as
mountains, sky, and oceans.

Soft Focus This setting makes your photos look as if they were
taken with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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Using the Custom mode

The Custom mode offers ready-made settings designed for
printing text and graphs and for applying a color-matching
method. You can also create and save your own custom settings.
See “Using the Advanced settings” on page 4-9 for details.

You can select from the following ready-made settings.

Follow the steps below to select a Custom setting.

1. Verify the Media Type and Ink settings in the Print dialog box.
For details, see “Making the Media Type setting” on page 4-3.

2. Click the Custom button in the Print dialog box. This enables
the Custom Settings list, located below and to the right of the
Custom radio button.

3. From the Custom Settings list, select the most appropriate
setting for the type of document or image you will print.

Text/Graph This setting is good for printing
presentation documents such as graphs
and charts.

Economy This setting is best for printing drafts of text

ColorSync This setting automatically adjusts printout
colors to match colors on your screen.
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4. When you choose a Custom setting, other settings such as
Print Quality, Halftoning, and Color are made automatically.
Changes to these settings are reflected in the display on the
left side of the Print dialog box.

Using the Advanced settings

The settings in the Advanced dialog box give you complete
control over your printing environment. Use these settings to
experiment with new printing ideas, or to fine-tune a range of
print settings to meet your individual needs. Once you are
satisfied with your new settings, you can give them a name and
add them to the Custom Settings list.

Making the Advanced settings

Follow the instructions below to make Advanced settings.

1. Click the Custom button in the Print dialog box, then click
the Advanced button. The Advanced dialog box appears.

2. Select the Media Type that you loaded in the printer. For
details, see “Making the Media Type setting” on page 4-3.

3. Choose Color or Black in the Ink setting.
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4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
❏ The PhotoEnhance option under Color Management only

affects images, not text or graphs. For example, if
Monochrome is selected from the Tone list (enabled when
PhotoEnhance is selected), only the images in a document
will be printed in monochrome. Any colored text or graphs in
the same document will be printed in color.

❏ Some settings may be unavailable depending on the Print
Quality, Media Type, and Ink settings you make.

6. Click OK to apply your settings and return to the Print dialog
box. Click Cancel to return to the Print dialog box without
applying your settings. To save your Advanced settings, see
the next section.

Saving and deleting your settings

To save your Advanced settings, click Save Settings in the
Advanced dialog box. The Custom Settings dialog box appears.

Type a unique name (up to 16 characters) for your settings in the
Name box, then click Save. Your Advanced settings will be added
to the Custom Settings list. You can save up to 10 different custom
settings.
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Note:
❏ You cannot apply the names of settings provided by EPSON to your

custom settings.

❏ You cannot delete the ready-made settings from the Custom Settings
list.

To delete a setting, select the setting in the Custom Settings dialog
box and click Delete.

Using your saved settings

To select your settings, click the Custom button in the Print dialog
box, then select your setting in the Custom Settings list, located
below and to the right of the Custom button.

If you change the Media Type or Ink settings when one of your
customized settings is selected in the Custom Settings list, the
selection shown in the list returns to Custom Settings. The
customized setting that was previously selected is not affected by
the change. To return to your customized setting, simply reselect
it in the list.

Changing the page setup

In the Page Setup dialog box, you can change the paper size,
specify the paper orientation, reduce or enlarge your printout,
and adjust the printable area.
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Choose Page Setup from the File menu of your application. The
Page Setup dialog box appears.

You can make the following settings in the Page Setup dialog box.

Paper Size Select the paper size you want to use. If you want
to define a custom paper size, see “Defining a
custom paper size” on page 4-14.

Paper Source Select the paper source you wish to use from the
following selections.

Auto Sheet Feeder:
Select this when printing on normal paper.

Roll Paper:
Select this when printing on roll paper. This leaves
a 3 mm margin on both the right and the left sides
of the roll paper while the document prints.

Roll Paper [Zero Margins]:
Select this only when printing on roll paper which is
89 or 100 mm in width. This eliminates the margins
on both sides of the roll paper while the document
prints.

Orientation Select Portrait (tall) or Landscape (wide) to change
the orientation of your printout. If you need to print
close to the bottom of the page, select the Rotate
by 180 degrees check box.

Reduce or
Enlarge

Use this setting to reduce or enlarge the size of your
image from 25% to 400%.
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Printable Area Use the options in the Printable Area box to adjust
the total area available for printing when Auto
Sheet Feeder is selected as the paper source. This
feature is not available when Roll Paper or Roll
Paper [Zero Margins] is selected.

If you want to position your printout at equal
distances from the edges of the paper., select
Centered. If you need to increase the printable
area, select Maximum. Do not select Maximum
when using Premium Glossy Photo Paper.

Note:
When Maximum is selected, the print quality may
decline at the edges of the printout. Before printing
large jobs using this setting, print a single sheet to
confirm quality.
When Maximum is selected, make sure the paper
loaded in the sheet feeder is not curled.

Roll Paper
Option

The Roll Paper Option are only available when Roll
Paper or Roll Paper [Zero Margins] is selected as the
paper source. These features are not available
when Auto Sheet Feeder is selected.

The settings are as follows:

Banner Mode:
Select this mode when you wish to print multi-page
data as continuous data on the roll paper, rather
than as individual pages. When this check box is
selected, the Save roll paper check box is enabled.

Cut Sheet Mode:
Select this mode when you wish to print the multi-
page data as individual pages, rather than as
continuous data. When this check box is selected,
the Print page frame check box is enabled.

Save roll paper:
Select this check box when you wish to save roll
paper. When this check box is selected, the blank
portion of the last page of your document is not fed
through the printer. This feature is only available
when Banner Mode is selected.

Print page frame:
Select this check box to print a line on the roll paper
between pages in a multi-page document to
indicate where the paper should be cut. This
feature is useful when it is unclear where the page
breaks should be. This feature is only available
when Cut Sheet Mode is selected.
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Defining a custom paper size

If the appropriate paper size is not included in the Paper Size list
in the Page Setup dialog box, follow the steps below to define a
custom paper size.

1. In the Page Setup dialog box, click Customize. The following
dialog box appears.

2. To define a new paper size, click New. The dialog box updates
to allow you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size List.
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4. Specify the measurement unit as either Inches or cm.

5. Enter the width and the height of your paper.

6. Set the margin in the margin input box or the preview image.

7. Click OK. You return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you
create will appear in the Paper Size menu in the Page Setup dialog
box.

To delete a custom paper size, click Customize in the Page Setup
dialog box, select it from the list in the Custom Paper dialog box,
and click Delete.

Copying a paper size

1. Select the existing paper size to copy, and click Copy.

2. Specify the measurement unit as either inches or cm.

3. Set the margin in the margin input box or the preview image.

4. Click OK.

Setting the Print Time

You can specify the time that you want the printer to begin
printing your document. Follow these steps.
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1. Click the Background Printing icon button in the Print
dialog box. The Background Printing dialog box opens.

2. Select On as the Background Printing option, if necessary.

3. Select Urgent, Normal, Print at, or Hold as the Print Time
option.

If you select Print at, use the arrows beside the date and time
boxes to specify the date and time you want to print the
document.

Note:
Make sure the computer and printer will be turned on at the date
and time you specify.

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure your print settings are as
you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON
Monitor3 utility. See “Using EPSON Monitor3” on page 5-5 for details.
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Modifying the page layout

You can modify the page layout of your document using the
printer driver settings located in the Layout dialog box, shown
below. To open this dialog box, click Print on the File menu of your
application and click the Layout icon button in the Print dialog
box. The Layout dialog box appears.

The Layout dialog box allows you to automatically match the
document size to the paper size, place watermarks on documents,
print two or four pages on a single sheet of paper, print poster-
size images by enlarging one page to cover several sheets, or set
the order in which you would like the pages of your document to
print.

You can also set the print order for your printout. Select collate to
print one set at a time, or Reverse Order to determine the order
in which you print multiple copies of your document.
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Fitting your document to the paper size

You can proportionally enlarge or reduce the size of the image to
make it fit the paper size you select in the Paper Size list. To do
this, select the Fit to Page check box, then specify the paper size
you loaded in the printer in the Paper Size list.

Printing a watermark on your document

To print a watermark in the background of your printed
documents or images, select the Watermarkcheck box in the Page
Layout dialog box.

Select the watermark you want to print from the Name list, then
specify its position, size, color, and intensity. You can change the
position and size of the watermark by dragging it with your
mouse in the preview window at the left.

You can also add your own text-based or image-based
watermarks to the Name list. Follow these steps.
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1. Click the Add/Del button beside the Name list. The following
dialog box appears.

2. To use an image file as a watermark, click the Add PICT
button. Specify the desired image file, then click Open.

To create a text-based watermark, click the Add Text button.
Type the text in the Text box, select a font and a text style, then
click OK.
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3. The image file name or the watermark text appears in the
Mark Name list in the Watermark dialog box. To change the
name of an image watermark, click it in the list, then type a
new name. When a text watermark is selected in the Name
list, you can edit the text, and change the font and text style,
by clicking the Edit Text button.

4. Click OK to add your watermark to the Name list in the Page
Layout dialog box.

Printing two or four pages on one sheet

To print two or four pages of your document on one sheet of
paper, select the Multi-Page check box in the Page Layout dialog
box, then click N-up.
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You can make the following settings.

Printing posters

A single document page can be enlarged to cover 4, 9, or 16
printed sheets of paper. To print a poster-size image, select the
Multi-Page check box in the Page Layout dialog box, then click
Poster.

You can make the following settings.

2 Pages
4 Pages

Prints two or four pages of your document on
a single piece of paper.

Page Order Allows you to specify the order in which the
pages will be printed on the sheet of paper.

Print page
frames

Allows you to print a frame around each page
on the sheet of paper.

1 page covers xx sheets Specifies how many printed sheets of paper
the enlarged document page is to cover.
You can select 4, 9, or 16 pages.

Print Cutting Guidelines Prints border lines on the images to guide
you when trimming the pages.
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If you only want to print a few of the panels without printing the
entire poster, click Panel Selection, then click the panels you
don’t wish to print, and then click OK. Only the panels that you
did not click will be printed.

Previewing your printout

The Preview feature allows you to see how your document will
look before actually printing it. Follow these steps to preview
your document.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box. The
Print button changes into a Preview button.

Note:
Use the Preview icon button to switch between the Print,

Preview, and Save File modes. Click the icon to select the
mode you want. For information on the Save File mode, see “Saving
print data in files” on page 4-24.

Overlapping Panels Slightly overlaps the images so that they can
be aligned more precisely.
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3. Click the Preview button. The Preview dialog box appears
and displays a preview of your document.

The Preview dialog box contains six icon buttons you can use to
perform the following functions.

Selection This feature lets you select, move, and
resize watermarks.

Zoom This feature enlarges the or reduces the
size of the previewed page.

Margin
Display/
Non-
Display

This feature displays or hides borderlines
which indicate the printable area.

Watermark
Editing

This button opens the Watermark Edit box.
This dialog box allows you to add
watermarks to the document, and to
change any of the current watermark
settings.

Add Page

Remove
Page

These buttons let you select or deselect
the pages you want to print from the list
on the left side of the preview window.
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4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click
Cancel. The Preview and Print dialog boxes close with the
current print settings preserved. Open the Print dialog box
again to make additional changes to the print settings.

Saving print data in files

You can save print data in a file by using the Save File icon
button in the Print dialog box. This feature lets you print the data
at a later time simply by double-clicking the saved file. Follow
these steps.

Note:
Use the Preview icon button to switch between the Print,

Preview, and Save File modes. Click the icon to select the mode
you want.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box
repeatedly until the Print button changes into the Save File
button.

3. Click the Save File button. The following dialog box appears.

4. Select the location where you want to save the file, then type
a file name into the Save As box and click Save.
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When you want to print the data, double-click the file to open
EPSON Monitor 3. Click the Resume button to send the data
to the printer.

Using the Printer Utilities

EPSON printer utilities allow you to check the current printer
status and to perform some printer maintenance from your
computer screen. To access the utilities, click the Utility icon
button in the Print or Page Setup dialog box, then click the button
for the utility you want to use.

EPSON StatusMonitor

The StatusMonitor utility monitors the printer status. If it detects
a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining
before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button
in the Utility dialog box. For details, see “Using EPSON
StatusMonitor” on page 5-2.
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Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment
utilities while printing is in progress; otherwise, your printout may be
marred.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for
clogging. Check the nozzles if you notice print quality has
declined and also after cleaning to confirm that the print head
nozzles have been cleaned. If the nozzle check indicates the print
head needs cleaning, you can access the Head Cleaning utility
directly from the Nozzle Check utility. For details, see “Checking
the Print Head Nozzles” on page 8-2.

Head Cleaning

This utility cleans the print head. You may need to clean the head
when you notice print quality has declined. Use the Nozzle Check
utility first to confirm that the print head needs to be cleaned. For
details, see “Cleaning the Print Head” on page 8-4.

Print Head Alignment

This utility aligns the print head. Use this utility if you notice a
misalignment of vertical or horizontal lines.

Configuration

Clicking this button opens the Configuration dialog box, where
you can change the way the StatusMonitor utility notifies you
when the printer status changes. For details, see “Making
Configuration Settings” on page 5-3.
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Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer
error, it will inform you with an error message.

You can also use this utility to check ink levels before printing.
When open, EPSON StatusMonitor displays the amount of ink
remaining at the time it was opened. To update the ink level
information, click the Update button.

Accessing EPSON StatusMonitor

To access EPSON StatusMonitor, follow the steps below.

1. Click Print or Page Setup on the File menu of your
application.

2. Click the Utility icon button in the dialog box.
5-2 Checking Printer Status and Managing Print Jobs for Macintosh



3. Click the EPSON StatusMonitor button in the Utility dialog
box. The following dialog box appears.

Note:
When you install a Light Capacity ink cartridge, the Ink Level display
will show that the cartridge is only half full. This is because a Light
Capacity ink cartridge only contains half of the amount of ink as a regular
cartridge.

Making Configuration Settings

If you want to change the way the StatusMonitor utility monitors
your printer, follow the steps below.

1. Click Print or Page Setup on the File menu of your
application.

2. Click the Utility icon button in the dialog box.
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3. Click the Configuration button. The Configuration Settings
dialog box appears.

This dialog box allows you to make the following settings:

Error notification Choose how EPSON StatusMonitor notifies
you in case of an error.

Warning Choose how EPSON StatusMonitor notifies
you if a warning message becomes
necessary.

Temporary Spool
folder

Choose the folder for temporary spooling
of print data.

Temporary High Speed
Copies folder

Choose the folder for multiple-copy print
data storage.

Data will be sent to the
printer after being
stored on your disk.

Select this check box to prevent horizontal
banding in your printout. By default,
graphics data is sent by the computer to
the printer in rectangular bands, which
prevents the printer from having to
reconstruct an entire image in memory
before printing it. Selecting this check box
will make the computer temporarily store
the image data on its hard drive and then
send it to the printer as a whole to prevent
banding in the printed image.

Check for errors before
starting to print.

Select this check box if you want to check
for errors before starting to print.
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Using EPSON Monitor3

After you send a print job to the printer, you can use the EPSON
Monitor3 utility to check, cancel, or change the priority of print
jobs that are queued for printing. This utility also shows the status
of the job currently being printed.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow these steps.

1. First, turn on Background Printing in the Chooser or in the
Background Printing dialog box.

2. Send a print job to the printer.

3. Select EPSON Monitor3 from the Application menu at the
right end of the menu bar. A dialog box similar to one below
opens.

Check the ink level
before starting to print.

Select this check box if you want to check
the ink level before starting to print.
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Note:
You can also open EPSON Monitor3 by double-clicking the EPSON
Monitor3 icon in the Extensions folder.

Managing print jobs with EPSON Monitor3

With EPSON Monitor3, you can manage print jobs as follows:

❏ Use the buttons below to hold, resume, and delete print jobs
for documents selected in the dialog box. First, select the
appropriate print job, then click the applicable button.

❏ Click Stop Print Queue to stop printing. Click Start Print
Queue to resume printing.

❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it (this function is
disabled when you are printing the ESC/P command file).

❏ Double-click Copies to change the number of copies to print
out.

Hold Stops printing and holds the current print job
in the print queue

Resume Resumes printing

Delete Stops printing and deletes print job from the
print queue

Print Head
Cleaning

Starts the Print Head Cleaning utility

Status
Monitor

Starts the EPSON StatusMonitor, which
displays the amount of ink remaining
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❏ Click the Show details arrow to open an extension at the
bottom of the EPSON Monitor3 dialog box, similar to the one
below. The extended dialog box displays detailed
information on a selected document’s printer driver settings.

Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the
steps below.

Note:
You can also change the priority of print jobs whose print times were
previously set in the printer driver’s Background Printing dialog box.
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1. Click the Show details arrow at the bottom of the EPSON
Monitor3 dialog box. You will see an extended dialog box
similar to the one below.

2. Click the name of the document whose priority you wish to
change in the Document Name column.

3. From the Priority list, select Urgent, Normal, Hold, or Print
Time.

Note:
If you select Print Time, a dialog box appears where you can specify
the date and time that the document will print. Make sure that your
printer and computer are turned on at the time you specify.
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For Windows 95 and 98 Users

This section tells you how to set up your printer so that other
computers on the network can use it.

First, you need to set up the printer as a shared printer on the
computer to which the printer is connected. Then, you must
specify the network path to the printer from each computer that
will use it, and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a
network. To connect your printer directly to a network without setting
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

Follow these steps to share a printer connected directly to your
computer with other computers on a network.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click Network.

3. Click the File and Print Sharing button.

4. Select the I want to be able to allow others to print to my
printer(s) check box and click OK.
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5. In the Network dialog box, click OK.

6. In the Control Panel, double-click Printers.

Note:
❏ If a dialog box requesting the Windows 95 or 98 CD-ROM

appears, insert the CD-ROM in the CD-ROM drive, then
follow the messages on the screen.

❏ If a dialog box appears requesting you to restart your computer,
do so. Then open the Printers folder, and continue from step 7.

7. Select your printer in the Printers window, and click Sharing
on the File menu.

8. Select Shared As and enter the printer information as
necessary, then click OK.
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Accessing the printer through a network

To access your printer from another computer on the network,
follow these steps.

Note:
Your printer must be set up as a shared resource on the computer to
which it is directly connected before you can access it from another
computer. For instructions, see “Setting up your printer as a shared
printer” on page 6-2.

1. On the computer from which you want to access the printer,
click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon.

3. The Add Printer Wizard screen appears. Click Next.

4. Click Network printer, then click Next.

5. Click Browse.
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6. Double-click the icon of the computer that is directly
connected to the printer. Then click the printer’s icon.

7. Click OK and follow the messages on the screen.

For Windows NT 4.0 Users

This section tells you how to set up your printer so that other
computers on the network can use it.

Note:
This section is written for small network users only. If you are on a large
network and would like to share your printer, consult your network
administrator.

First, you need to set up the printer as a shared printer on the
computer to which the printer is connected. Then, you must
specify the network path to the printer from each computer that
will use it, and install the printer software on those computers.
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Setting up your printer as a shared printer

Follow these steps to share a printer that is connected directly to
your computer with others on a network.

1. Click Start, point to Settings, and click Printers.

2. Select your printer, then click Sharing on the File menu.

3. Click Shared and enter the Share Name.

4. Click OK.

Note:
Do not choose any drivers from the Alternate Drivers list.

Accessing the printer through a network

To access your printer from another computer on the network,
follow these steps.
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Note:
Your printer must be set up as a shared resource on the computer to
which it is directly connected before you can access it from another
computer. For instructions, see “Setting up your printer as a shared
printer” on page 6-6.

1. Install the printer driver to the client computer from the
software CD-ROM.

2. Double-click the Printers icon from the Control Panel, right-
click on your printer’s icon, then click Properties from the list
of options.
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3. Click the Ports tab, then click Add Port.

4. The following dialog appears. Select Local Port, then click
New Port.
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5. The following dialog box appears. In the text box, type:
\\name of computer that is connected to the
printer\name of the shared printer

6. Click OK.

7. In the Printer Ports dialog box, click Close to return to the
Ports menu.
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8. On the Ports menu, make sure that the new port is added and
the corresponding check box is selected. Click OK to close the
printer driver.

For Macintosh Users

This section tells you how to set up the printer so that you can use
it on an AppleTalk network. By setting up your printer as a shared
printer, your local printer is connected to the network and can be
used by other computers.

First, you need to setup the printer as a shared printer on the
computer to which the printer is connected. Then, you must
specify the network path to the printer from each computer that
will use it, and install the printer software on those computers.

Setting up your printer as shared printer

Follow these steps to share a printer connected directly to your
computer with other computers on an AppleTalk network.

1. Turn on the printer.
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2. Choose Chooser from the Apple menu and click the printer's
icon. Then select the port to which the printer is connected.

3. Click the Setup button. The following dialog box appears.

4. Select the Share this Printer check box, then type the printer
name and password information as necessary.

5. Click OK. The name of the shared printer appears in the port
list in the Chooser.

6. Close the Chooser.
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Accessing the printer through a network

To access your printer from another computer on the network,
follow these steps.

1. Turn on your printer.

2. On each computer from which you want to access the printer,
choose Chooser from the Apple menu. Then click your
printer’s icon and select the printer port you want to use from
the Select a printer port list on the right. You can only select
from the printers connected to your current AppleTalk zone.

3. If the following dialog box appears, enter the password for
the printer, then click OK.

4. Select the appropriate Background Printing option button to
turn background printing on or off.

5. Close the Chooser.
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Replacing an Ink Cartridge

This printer uses ink cartridges equipped with IC chips. The IC
chip accurately monitors the amount of ink used by each
cartridge, so even if a cartridge is removed and later inserted
again, all of its ink can be used. However, some ink is consumed
each time the cartridge is inserted because the printer
automatically checks reliability.

Using the printer's control panel

The printer’s indicator lights will inform you when it is time to
obtain a replacement ink cartridge and when it is time to replace
an empty cartridge.

This table describes the status of the lights on your printer and
the actions you need to take.

O = on, F = flashing

Lights Action

B  F Obtain a replacement black ink cartridge (T007) or
(T010).

B  O Replace the empty black ink cartridge.

A  F Obtain a replacement color ink cartridge (T008).

A  O Replace the empty color ink cartridge.
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w Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there
may be some ink around the ink supply port. If ink gets on
your skin, wash the area thoroughly with soap and water. If
ink gets into your eyes, flush them immediately with water.
If discomfort or vision problems remain after a thorough
flushing, see a doctor immediately.

c Caution:
❏ EPSON recommends the use of genuine EPSON ink

cartridges. Other products not manufactured by EPSON
may cause damage to your printer not covered by EPSON's
warranties.

❏ Leave the old cartridge installed in the printer until you have
obtained a replacement; otherwise, ink remaining in the print
head nozzles may dry out.

❏ Do not refill the ink cartridges. The ink cartridges for this
printer are not for refill. The printer calculates the amount
of ink remaining using an IC chip on the ink cartridge: Even
if the cartridge is refilled, the amount of ink remaining will
not be recalculated by the IC chip and the amount of ink
available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if

the other cartridge still contains ink. Before printing, replace the
empty cartridge.

❏ In addition to the ink used during document printing, ink is
consumed during the print head cleaning operation and during the
self-cleaning cycle which is performed when the printer is turned
on, and during ink charging when the ink cartridge is installed in
the printer.
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For more information about ink cartridges, see “When handling
the ink cartridges” on page -6.

To replace an ink cartridge using the orange ink cartridge
replacement button, follow the steps below.

1. Make sure the printer is on. The P power light should be on,
but not flashing. (Determine which cartridge needs to be
replaced as indicated by the B black and A color ink out
lights.)

2. Lower the output tray at the front of the printer, then open
the printer cover.

3. Press the orange ink cartridge replacement button. The print
head moves left to the ink cartridge replacement position, and
the P power light begins flashing.

c Caution:
Do not move the print head by hand as this may damage the
printer. Always press the orange ink replacement button to
move it.
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4. Lift up the clamp that holds the cartridge you want to replace
as far as it will go. The cartridge rises partly out of the
cartridge holder.

5. Lift the cartridge out of the printer and dispose of it properly.
Do not take the used cartridge apart or try to refill it.

The illustration shows color ink
cartridge replacement. To
replace the black ink cartridge,
lift up only the smaller clamp on
the left.
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6. Remove the new ink cartridge from its protective bag. Next,
remove only the yellow tape seal from the cartridge.

black ink cartridge (T007) color ink cartridge (T008)
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c Caution:
❏ You must remove the yellow tape seal from the cartridge

before installing it; otherwise, the cartridge will become
unusable and you will be unable to print.

❏ If you have installed an ink cartridge without removing
the yellow tape seal, you must remove the cartridge and
install a new one. Prepare the new cartridge by removing
the yellow tape seal, then install it in the printer.

❏ Do not remove the blue portion of the tape seal from the
top of the cartridge; otherwise, the print head may
become clogged and be unable to print.

❏ Do not remove the tape seal from the bottom of the
cartridge; otherwise, ink will leak.

❏ Do not touch the green chip on the side of the cartridge;
otherwise, normal operation and printing may not be
possible.

Do not touch this part.
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7. Align the tabs on the ink cartridge so that they are resting on
the tabs protruding from the base of the opened ink cartridge
clamp. Do not apply excessive force to the cartridge.

c Caution:
Make sure the ink cartridge tabs are not under the tabs
protruding from the base of the opened ink cartridge clamp,
as this could damage the clamp.
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8. Press the ink cartridge clamp down until it locks into place.

c Caution:
After you remove an ink cartridge from the printer, please
insert a new one immediately. If no cartridge is present, the
print head may dry out and become unable to print.

9. Press the orange ink cartridge replacement button. The
printer moves the print head and begins charging the ink
delivery system. This process takes about one minute to
complete. When the ink charging process is finished, the
printer returns the print head to its home position, the
P power light stops flashing and stays on, and the B black and
A color lights turn on.

The illustration shows color ink
cartridge replacement. To
replace the black ink cartridge,
replace only the cartridge held
by the smaller clamp on the left.
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c Caution:
The P power light continues to flash while the printer
performs the ink charging operation. Never turn off the
printer while this light is flashing. Doing so can result in
incomplete charging of ink.

10. Close the printer cover.

Using the Status Monitor 3

You can monitor the remaining ink levels from your computer
and view on-screen instructions for replacing a low or empty ink
cartridge using the EPSON Status Monitor 3 utility.

When an ink cartridge is low or empty, click the How to button
in the EPSON Status Monitor 3 window. The print head moves to
the ink cartridge replacement position. Follow the on-screen
instructions to replace the cartridge.

For more information on using EPSON Status Monitor 3, see
“Using EPSON Status Monitor 3” on page 3-4.
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Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in
the printed image are missing, you may be able to identify the
problem by checking the print head nozzles.

You can check the print head nozzles from your computer using
the Nozzle Check utility in the printer software, or from the
printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Follow the steps below to use the Nozzle Check utility.

Note:
Do not use the Nozzle Check utility while printing is in progress;
otherwise, your printout may be marred.

For Windows users

1. Make sure A4 or Letter size paper is loaded in the sheet feeder.

2. Access the printer software. If you need instructions, see
“Accessing the printer software” on page 2-3.

3. Click the Utility tab, then click the Nozzle Check button.

4. Follow the instructions on your screen.

For Macintosh users

1. Make sure A4 or Letter size paper is loaded in the sheet feeder.

2. Access the Print or Page Setup dialog box.

3. Click the Utility icon button, then click the Nozzle Check
button.

4. Follow the instructions on your screen.
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Using the control panel buttons

Follow the steps below to check the print head nozzles using the
control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet
feeder.

3. Hold down the E load/eject button (➀ in the illustration
below) and press the P power button (➁ in the illustration
below) to turn on the printer.

4. Then release both buttons.
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The printer prints an operation check page including your
printer’s ROM version information, the ink counter code, and a
nozzle check pattern. Below are sample printouts.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual test prints in color
(CMYK).

If the nozzle check page does not print satisfactorily (for example,
if any segment of the printed lines is missing) there is a problem
with the printer. This could be a clogged ink nozzle or a
misaligned print head. See the next section for details on cleaning
the print head. For information on aligning the print head, see
“Aligning the Print Head” on page 8-9.

Cleaning the Print Head

If you find that the printed image is unexpectedly faint or dots in
the printed image are missing, you may be able to solve these
problems by cleaning the print head, which ensures that the
nozzles are delivering ink properly.

You can clean the print head from your computer with the Head
Cleaning utility in the printer software, or from the printer itself
by using the printer’s control panel buttons.

segments are missing
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Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting

ink, clean the print head only if print quality declines; for example,
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. This saves ink.

❏ When the B black or A color ink out light is flashing or on, you
cannot clean the print head. Replace the appropriate ink cartridge
first.

❏ Do not start the Head Cleaning or Nozzle Check utility while
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Follow the steps below to use the Head Cleaning utility.

For Windows users

1. Make sure that the printer is on and both B black and A color
ink out lights are off.

Note:
If the B black or A color ink out light is flashing, you can not clean
the print head. Replace the appropriate ink cartridge first.

2. Access the printer software. If you need instructions, see
“Accessing the printer software” on page 2-3.

3. Click the Utility tab, then click the Head Cleaning button.

4. Follow the messages on your screen.

The P power light flashes while the printer performs the
cleaning cycle. It takes about thirty seconds to complete.
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c Caution:
Never turn off the printer while theP power light is flashing.
Doing so may damage the printer.

5. When the P power light stops flashing, click Print nozzle
check pattern in the Head Cleaning dialog box to confirm
that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints
in color.

In the check pattern, if you find that any segments are missing
from the test lines, you may need to repeat the head cleaning and
print the nozzle check pattern again.

If print quality hasn’t improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be replaced.
To replace an ink cartridge, see “Replacing an Ink Cartridge” on
page 7-2.

segments are missing
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If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at
least one minute every month.

For Macintosh users

1. Make sure that the printer is on, and the B black and A color
ink out lights are off.

2. Click the Utility icon buttonin the Print or Page Setup
dialog box, then click the Head Cleaning button.

3. Follow the on-screen instructions.

The P power light flashes while the printer performs the
cleaning cycle. This operation takes about thirty seconds to
complete.

c Caution:
Never turn off the printer while P power light is flashing.
Doing so may damage the printer.

4. When the P power light stops flashing, click the
Confirmation button in the Head Cleaning dialog box to
print a nozzle check pattern and to reset the cleaning cycle.
Use the check pattern to confirm the head is clean. See
page 148 to see a sample of the nozzle check pattern.

If print quality hasn’t improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be replaced.
To replace an ink cartridge, see “Replacing an Ink Cartridge” on
page 7-2.
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If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at
least one minute every month.

Using the control panel buttons

Follow the steps below to clean the print head using the control
panel buttons.

1. Make sure that the P power light is on and that both the
B black and A color ink out lights are off.

Note:
If the B black or A color ink out light is flashing or on, you cannot
clean the head.

2. Hold down the R cleaning button for three seconds.

The printer starts cleaning the print head and the P power
light begins flashing. Print head cleaning takes about thirty
seconds to complete.
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c Caution:
Never turn off the printer while theP power light is flashing.
Doing so may damage the printer.

3. When the P power light stops flashing, print a nozzle check
pattern to confirm that the head is clean and to reset the
cleaning cycle.

If print quality hasn’t improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be replaced.
To replace an ink cartridge before it is empty, see “Replacing an
Ink Cartridge” on page 7-2.

If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at
least one minute every month.

Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to
solve this problem from your computer using the Print Head
Alignment utility in your printer software. Follow the directions
below.

Note:
Do not start the Print Head Alignment utility while printing is in
progress; otherwise, your printout may be marred.
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For Windows users

1. Make sure A4 or Letter size plain paper is loaded in the sheet
feeder.

2. Access the printer software. If you need instructions, see
“Accessing the printer software” on page 2-3.

3. Click the Utility tab, then click the Print Head Alignment
button.

4. Follow the messages on your screen to align the print head.

For Macintosh users

1. Make sure A4 or Letter size plain paper is loaded in the sheet
feeder.

2. Click the Utility icon button in the Printor Page Setup
dialog box, then click the Print Head Alignment button.

3. Follow the messages on your screen to align the print head.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly
several times a year as follows.

1. Make sure the printer is turned off and all the printer’s lights
are off. Then unplug the power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from
the sheet feeder.

4. If the outer case or the inside of the sheet feeder is dirty, clean
it with a soft, clean cloth dampened with mild detergent. Keep
the printer cover closed to prevent water getting inside.
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5. If the inside of the printer accidentally gets soiled with ink,
wipe it off with a damp cloth.

w Warning:
Be careful not to touch the gears inside the printer.

c Caution:
❏ Never use alcohols or thinners to clean the printer; these

chemicals can damage the components as well as the case.

❏ Be careful not to get water on the printer mechanism or
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants;
unsuitable oils can damage the mechanism. Contact your
dealer or a qualified service person if lubrication is needed.

Transporting the Printer

If you need to transport your printer, carefully prepare and repack
it as described below using the original box (or similar box that
printer fits) and packing materials.

1. Open the printer cover and make sure that the print head is
in the home (far right) position. If not, turn on the printer and
wait until the print head returns to the home position. Then
turn off the printer and close the printer cover.

c Caution:
Leave the ink cartridges installed when you transport the
printer. Removing the cartridges during transport can
damage the printer.

2. Unplug the power cord from the electrical outlet, then
disconnect the interface cable from the printer.
Maintenance 8-11



3. Remove the paper from the sheet feeder and remove the paper
support.

4. Open the printer cover again. Secure the ink cartridge holder
to the printer with tape as shown below, then close the printer
cover.

5. Push in the output extension tray, and then raise the output
tray.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

Updating Software

Follow the directions in this section if you have upgraded your
computer from Windows 95 to Windows 98 or if you are a
Windows NT 4.0 user and wish to update your printer driver from
a previous version.
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Updating to Windows 98

If you have upgraded your computer’s operating system from
Windows 95 to Windows 98, you must uninstall your printer
software and then install it again. Uninstall the printer software
by double-clicking the Add/Remove Programs icon in the
Windows Control Panel and selecting EPSON Printer Software
from the list. Click the Add/Remove button and then Yes in the
dialog box that appears. Click OK in the Add/Remove Programs
Properties dialog box and install the printer software again.

Updating the driver in Windows NT 4.0

When you update the printer driver in Windows NT 4.0, please
be sure to uninstall the previous printer driver before you install
the new driver. Installing over the existing printer driver results
in a failure to update. To uninstall the printer driver, double-click
the Add/Remove Programs icon in the Windows Control Panel.
The Add/Remove Programs properties dialog box appears.
Select EPSON Printer Software from the list, click Add/Remove,
and then OK. Then, install the printer software again.
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Troubleshooting
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Diagnosing the Problem

Troubleshooting printer problems is best handled in two easy
steps: first diagnose the problem, then apply likely solutions until
the problem is fixed. The information that you need to diagnose
the most common problems is provided by the printer’s control
panel lights and by the Status Monitor utility.

Use the information presented in this chapter to pinpoint the
source of your problem, then apply the recommended solutions
until the problem is solved.
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Error indicators

You can identify many common printer problems using the lights
on your printer’s control panel. If your printer stops working and
the lights are on or flashing, use the following table of panel light
patterns to diagnose the problem, then follow the recommended
corrective measures.

Lights Problem and Solution

S O
Paper out

No paper is loaded in
the printer.

Load paper in the sheet
feeder, then press the E load/
eject button. The printer
resumes printing and the light
goes out.

S F
B N
AN

Paper jam

Paper has jammed in
the printer.

Press the E load/eject button.
The printer ejects the jammed
paper and then resumes
printing. If the error is not
cleared, open the printer
cover and remove the
jammed paper. Then reload
paper in the sheet feeder and
press the E load/eject button.
The printer resumes printing.

B F
Ink low (black ink cartridge)

The black ink cartridge
is nearly empty.

Obtain a replacement black
ink cartridge (T007) or (T010).

B O
Ink out (black ink cartridge)

The black ink cartridge
is empty or not
installed.

Replace the black ink
cartridge with a new one
(T007) or (T010). See
“Replacing an Ink Cartridge”
on page 7-2 for details.

Wrong ink (black ink cartridge)

The installed black ink
cartridge cannot be
used by this printer.

Use the appropriate black ink
cartridge (T007) or (T010). See
“Replacing an Ink Cartridge”
on page 7-2 for details.
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O = on, N = off, F = flashing

Status Monitor 3

The Status Monitor 3 utility provides status messages and a
graphic display showing the current state of the printer.

If a problem occurs while printing, an error message appears in
the Progress Meter window.

A F
Ink low (color ink cartridge)

The color ink cartridge
is nearly empty.

Obtain a replacement color
ink cartridge (T008).

A O
Ink out (color ink cartridge)

The color ink cartridge
is empty or not
installed.

Replace the color ink
cartridge with a new one
(T008). See “Replacing an Ink
Cartridge” on page 7-2 for
details.

Wrong ink (color ink cartridge)

The installed color ink
cartridge cannot be
used by this printer.

Use the appropriate color ink
cartridge (T008). See
“Replacing an Ink Cartridge”
on page 7-2 for details.

P F
S F
B O
AO

Carriage error

The print head
carriage is obstructed
by jammed paper or
other foreign material
and cannot return to
the home position.

Turn off the printer. Open the
printer cover and remove any
paper from the paper path by
hand. Then turn the printer
back on.

If the error is not cleared,
contact your dealer.

P F
S F
B F
AF

Unknown printer error

An unknown printer
error has occurred.

Turn off the printer, and
contact your dealer.
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When ink is out, click the How To button in the Status Monitor or
Progress Meter window and EPSON Status Monitor 3 will lead
you step-by-step through the cartridge replacement procedure.

Running a printer operation check

Performing a printer operation check can help you determine
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

If you use the parallel interface, unlock the wire clips on both
sides of the interface connector and remove the ground
connector, if necessary. Then disconnect the cable from the
printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet
feeder.
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4. Hold down the E load/eject button and press the P power
button to turn on the printer. Then release both buttons.

The printer prints an operation check page including the version
of your printer’s ROM, the ink counter code, and a nozzle check
pattern.

Compare the quality of the printed check page with the sample
shown below. If there are no print quality problems, such as gaps
or missing segments in the test lines, the printer itself is all right
and the problem probably lies in the printer software settings,
application settings, the interface cable (be sure to use a shielded
cable), or the computer itself.

The above sample is in black and white, but the actual check page prints
in color (CMYK).
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If the check page does not print satisfactorily as shown below,
there is a problem with the printer. For example, if any segment
of the printed lines is missing, this could be a clogged ink nozzle
or a misaligned print head.

The above sample is in black and white, but the actual check pattern prints
in color.

Cancelling Printing

If the printouts are not what you expected and display incorrect
or garbled characters or images, you may need to cancel printing.
To cancel printing, follow the instructions below.

For Windows 95, 98 and NT 4.0

When you send a print job to the printer, the Progress Meter
appears on your computer screen.

Click the Stop button to cancel printing.

segments are missing
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For Macintosh

The procedure for canceling printing for Macintosh varies,
depending upon whether background printing is on or off.

When background printing is on

1. Select EPSON Monitor3 from the application menu.

2. Press the P power button to turn off the printer.

3. Click the name of the document which is printing in the
Document Name list, then click the Stop icon button to
cancel the print job.

When background printing is off

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press
the period (.) key to cancel the print job.
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Print Quality Could Be Better

If you are having print quality problems, try the solutions offered
in this section.

Horizontal banding

Try one or more of these solutions:

❏ Make sure the printable side of the paper is face up in the sheet
feeder.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.

❏ Select the Automatic as the Mode setting on your printer
driver’s Main menu (Windows) or in the Print dialog box
(Macintosh).

❏ Check the B black and A color ink out lights. If a light is
flashing, replace the ink cartridge. See “Replacing an Ink
Cartridge” on page 7-2.

❏ Make sure that Maximum is not selected as the Printable Area
setting in your printer driver. When this setting is selected,
banding may occur in the expanded area.

❏ Make sure the Media Type selected in the printer driver is
appropriate for the type of media loaded in the printer.

Vertical misalignment or banding

Try one or more of these solutions:

❏ Make sure the printable side of the paper is face up in the sheet
feeder.

❏ Run the Print Head Alignment utility.
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❏ Turn off the High Speed setting in your printer driver. For
instructions, see “Using the Advanced settings” on page 2-11
for Windows. For Macintosh, see “Using the Advanced
settings” on page 4-9.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.

❏ Make sure the Media Type setting selected in the printer
driver is right for the type of media loaded in the printer.

Color gaps

Try one or more of these solutions:

❏ Make sure your paper is not damaged, dirty, or too old. Also,
make sure the printable side of the paper is face up in the sheet
feeder.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.

❏ Check theB black andA color ink out lights. If one of the lights
is flashing, replace the appropriate ink cartridge. See
“Replacing an Ink Cartridge” on page 7-2.

❏ Adjust the color settings in your application software or your
printer driver. For instructions, see “Using the Advanced
settings” on page 2-11 for Windows or “Using the Advanced
settings” on page 4-9 for Macintosh.

❏ Select Automatic as the Mode setting on your printer driver’s
Main menu (Windows) or in the Print dialog box (Macintosh).

❏ Make sure the Media Type setting selected in the printer
driver is appropriate for the type of media loaded in the
printer.
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Incorrect or missing colors

Try one or more of these solutions:

❏ Change the Ink setting in your printer driver to Color. For
instructions, see “Using the Automatic mode” on page 2-8 for
Windows or “Using the Automatic mode” on page 4-6 for
Macintosh.

❏ Adjust the color settings in your application software or your
printer driver. For instructions, see “Using the Advanced
settings” on page 2-11 for Windows or “Using the Advanced
settings” on page 4-9 for Macintosh.

❏ Run the Head Cleaning utility. If colors are still incorrect or
missing, replace the color ink cartridge. If the problem
persists, replace the black ink cartridge. See “Replacing an Ink
Cartridge” on page 7-2.

Blurry or smeared printout

Try one or more of these solutions:

❏ Make sure your paper is dry and the printable side is facing
up. Also, make sure you’re using an acceptable paper type.
See “Paper” on page B-2 for specifications.

❏ Select Automatic as the Mode setting on your printer driver’s
Main menu (Windows) or in the Print dialog box (Macintosh).

❏ If the paper is curled toward the printable side, flatten it or
curl it slightly toward the opposite side.

❏ Set the adjust lever to the “+” position, and make sure the
Media Type setting in your printer driver is correct.

❏ Remove each sheet from the output tray as it is printed,
especially if you are using transparencies.
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❏ If you’re printing on glossy media or transparencies, place a
support sheet (or a sheet of plain paper) beneath the stack. Or,
load one sheet at a time.

❏ Run the Head Cleaning utility.

❏ Run the Print Head Alignment utility.

❏ Ink may have leaked inside the printer; wipe the inside of the
printer with a soft, clean cloth.

w Warning:
Be careful not to touch the gears inside the printer.

Printouts Are Not What You Expected

If one of the following problems has occurred, try the solutions
listed for the problem.

❏ Incorrect or garbled characters

❏ Incorrect margins

❏ Inverted image

❏ Blank pages print

Wipe here
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❏ Printout has smears on the bottom edge

❏ Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

❏ Select your printer as the default printer in Windows.

❏ Clear any stalled print jobs from the Spool Manager. For
instructions, see “Using EPSON Spool Manager” on page 3-3.

❏ Turn off the printer and computer. Make sure the printer’s
interface cable is securely plugged in.

❏ If you are using Windows NT 4.0, try to uninstall the EPSON
Printer Port. Click Start, point to Programs, then point to
EPSON Printers and click EPSON Printer Port Uninstall.
Follow the instructions on the screen.

Incorrect margins

Try one or more of these solutions:

❏ Check the margin settings in your application software. Make
sure the margins are within the printable area of the page. See
“Paper” on page B-2 for specifications.

❏ For Windows, check the settings in the Paper menu. Make
sure the settings are appropriate for the paper size you are
using.

For Macintosh, check the settings in the Page Setup dialog
box. Make sure the settings are appropriate for the paper size
you are using.
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Inverted image

Turn off the Flip Horizontal setting in the printer driver, or the
“Mirror” setting in your application software. For instructions,
see the online help for the printer driver or for your application.

For Macintosh, see also “Using the Advanced settings” on page
4-9.

Blank pages print

Try one or more of these solutions:

❏ Select your printer as the default printer in Windows.

❏ For Windows, check the settings in the Paper dialog box.
Make sure they are appropriate for the paper size you are
using.

For Macintosh, check the settings in the Page Setup dialog
box. Make sure they are appropriate for the paper size you
are using.

❏ Run the Head Cleaning utility to clear any clogged nozzles.

After trying one or more of these solutions, run a printer operation
check to check your results. See “Running a printer operation
check” on page 9-6 for details.

Printout has smears on the bottom edge

Try one or more of these solutions:

❏ If the paper is curled toward the printable side, flatten it or
curl it slightly toward the opposite side.
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❏ Set the adjust lever to the “+” position, and turn off the High
Speed setting in your printer driver’s Advanced dialog box.
The Advanced dialog box is accessible through the Main
menu (for Windows) or Print dialog box (for Macintosh)
when Custom is selected as the Mode setting. To turn this
option off, you may also need to change the Print Quality
setting.

Printing is too slow

Try one or more of these solutions:

❏ Make sure the Media Type setting in your printer driver is
correct. For instructions, see “Making the Media Type setting”
on page 2-5 for Windows or “Making the Media Type setting”
on page 4-3 for Macintosh.

❏ Select Automatic as the Mode setting on your printer driver’s
Main menu (Windows) or in the Print dialog box (Macintosh)
and then move the slider to Speed. For instructions, see
“Using the Automatic mode” on page 2-8 for Windows or
“Using the Automatic mode” on page 4-6 for Macintosh.

❏ Close any applications you are not using at the moment.

❏ If you upgraded from Windows 95 to Windows 98, uninstall
the printer software using Add/Remove Programs in the
Control Panel in Windows, then install the software again.

Printer Doesn't Print

If one of the following error indications is displayed, try the
solutions listed.

❏ All lights are off

❏ Lights came on and then went out
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❏ Only the power light is on

❏ The S paper out light is flashing or on

❏ One of the ink out lights is flashing or on

❏ Ink out lights are on and the other lights are flashing

All lights are off

Try one or more of these solutions:

❏ Press the P power button and make sure the printer is on.

❏ Turn off the printer and make sure the power cord is securely
plugged in.

❏ Make sure your outlet works and is not controlled by a wall
switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the
printer and unplug it immediately. Then, check the printer labels.

If the voltage does not match, DO NOT PLUG YOUR PRINTER
BACK IN. Contact your dealer.

Only the power light is on

Try one or more of these solutions:

❏ Turn off the printer and computer. Make sure the printer’s
interface cable is securely plugged in.

❏ Make sure there is no packing material in the printer.
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❏ Turn off the printer and computer and disconnect the
printer’s interface cable. Then print an operation check page.
See “Running a printer operation check” on page 9-6.

If the check page prints, make sure the printer software and
your application software are installed correctly.

❏ If you’re trying to print a large image, your computer may not
have enough memory to print. Try printing a smaller image.

❏ If you are using Windows NT 4.0, try to uninstall the EPSON
Printer Port. Click Start, point to Programs and EPSON
Printers, then click EPSON Printer Port Uninstall. Follow the
messages on the screen.

❏ Clear any stalled print jobs from the Spool Manager. For
instructions, see “Using EPSON Spool Manager” on page 3-3.

❏ If the printer sounds like it’s trying to print, but is unable to,
run the Head Cleaning utility.
If this doesn’t work, replace the ink cartridges. See “Replacing
an Ink Cartridge” on page 7-2 for instructions.

Paper out light is flashing or on

If the paper out light is flashing, remove any paper that may be
jammed in the printer.

If the paper out light is on, load more paper in the sheet feeder.

One of the ink out lights is flashing or on

If theB black orA color ink out light is flashing, ink is low. Prepare
a replacement cartridge.

If the B black or A color light is on, ink is out. Replace the
appropriate cartridge. See “Replacing an Ink Cartridge” on page
7-2.
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Ink out lights are on and the other lights are flashing

Follow the steps below.

1. Press the E load/eject button, then remove any paper in the
printer.

2. Turn the printer off. Check for and remove any foreign objects
or pieces of paper from inside the printer. Also, make sure
that there is sufficient space around the vent on the back of
the printer to allow proper ventilation. Remove any objects
blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove the foreign object by yourself, do not use force
and do not disassemble the printer. Call your dealer for assistance.

3. If the error is not cleared, contact your dealer.

Paper Doesn't Feed Correctly

If one of the following problems has occurred, try the solution(s)
listed for the problem.

❏ Paper doesn't feed

❏ Multiple pages feed

❏ The paper jams

❏ Paper isn't ejected fully or is wrinkled

Paper doesn't feed

Remove the stack of paper and make sure of the following:

❏ The paper isn’t curled or creased.
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❏ The paper isn’t too old. See the instructions that came with
the paper for more information.

❏ The paper isn’t loaded above the arrow on the left edge guide.

❏ The paper isn’t jammed inside. If it is, remove the jammed
paper.

Then, load the paper again. Make sure you follow any special
loading instructions that came with your paper. See also “Paper
Handling” on page 19.

Multiple pages feed

Remove the stack of paper and make sure the paper is not too thin.
See “Paper” on page B-2 for specifications. Fan the edges of the
stack to separate the sheets, then reload the paper.

If too many copies of a document are being printed, check the
Copies setting in both the printer driver and your application.
For instructions, see “Modifying the printout style” on page 2-14
for Windows or “Modifying the page layout” on page 4-17 for
Macintosh.

The paper jams

Press the E load/eject button to eject the jammed paper. If the
error message does not clear, open the cover and remove all the
paper inside, including any torn pieces. Then load the paper
again.

Note:
If you cannot remove the foreign object by yourself, do not use force and
do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.
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❏ The paper is of high-quality, loaded with the printable side
up.

❏ The paper stack was fanned before loading.

❏ The paper isn’t loaded above the arrow on the left edge guide.

❏ The left edge guide is adjusted to fit your paper.

Paper isn't ejected fully or is wrinkled

If the paper doesn’t eject fully, press the E load/eject button. Also
check the Paper Size setting in your application or printer driver.

If the paper is wrinkled when it comes out, it may be damp or too
thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area. See
“Paper” on page B-2 for specifications.

Where to Get Help

If your printer is not operating properly and you cannot solve the
problem using the troubleshooting information in your printer
documentation, contact customer support services for assistance.

Customer support will be able to help you much more quickly if
you give them the following information.

❏ Serial number of your printer
(The serial number label is on the back of the printer.)

❏ Printer model

❏ Brand and model of your computer
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❏ Printer software version
(Click About in your printer driver.)

❏ Windows version you are using

❏ Software application(s) you normally use with your printer
and their version number(s)
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Options

The following options are available for your printer.

Roll Paper Holder

A Roll Paper Holder C81111✽ is available from EPSON for your
printer.

Consumable products

The following ink cartridges and EPSON special media are
available for your printer.

Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

EPSON special media

EPSON offers specifically designed media for ink jet printers to
meet most high-quality printing needs.

Black ink cartridge Standard Capacity T007

Light Capacity T010

Color ink cartridge T009

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026
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EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6
(with envelopes)

S041147

EPSON Ink Jet Greeting Cards 5 × 8”
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10”
(with envelopes)

S041149

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Photo Paper (89mm × 7M) S041281

EPSON Photo Paper (100mm × 8M) S041279

EPSON Photo Paper (210mm × 10M) S041280

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154
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Note:
The availability of special media varies by location.

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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Basics of Color

This section describes the basic properties of color, the
relationships between colors, and how to use color to improve the
quality of your printed documents.

Properties of color

Color is composed of three properties: hue, saturation, and
brightness.

Hue
The name of the color, such as red, blue, or violet. The circle that
represents the relationship between all hues is called the hue
circle.

Saturation
The vividness of the color. This represents the amount of gray in
proportion to the hue.

Brightness
The relative lightness or darkness of the color.

The method for representing these properties is called the
Munsell renotation color system. The hue circle and the Munsell
renotation color system are useful to understand the properties
of color. See also the Color Guide.

Synchronizing monitor colors and printer colors

Your printer produces images by printing tiny patterns of ink dots
on paper. It uses the colors cyan (C), magenta (M), yellow (Y), and
black (K) to create a blending effect that makes you think you are
seeing millions of colors. This type of color, produced by
pigments that absorb some colors of light and reflect others, is
called subtractive.
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Note:
In theory, pure cyan, magenta, and yellow should produce black, but
actually they produce a muddy brown and must be combined with black
ink to produce a true black (K).

A cathode-ray tube (CRT) monitor produces images by
illuminating color phosphors on the screen with an electron gun.
(A phosphor is a substance that gives off light when irradiated.)
Each screen point (pixel) has three colored phosphors: red (R),
green (G), and blue (B).

Since the printer and monitor produce color images differently,
and the available range of color produced by the monitor and
printer are different, the image on the screen does not exactly
match your printed output all of the time. If you want to adjust,
or calibrate, the printed color to more closely match the on-screen
color, you may have to experiment with the printer driver
settings.

Additionally, color management software is available from a
variety of software and monitor companies to help you match
colors produced by your monitor and printer. See your image-
editing software documentation for information on color
matching.

monitor colors printer colors
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The range of colors that can be displayed:

Note:
When printing a scanned image, you may find it more difficult to match
colors. Because scanners create the original image data using CMYK,
the data format of your image will be changed twice.

Process of color printing

A printer produces color images by printing tiny patterns of ink
dots using CMYK colors as mentioned in the previous section.
Because most ink jet printers are not able to print different
gradations of the three primary colors, they must use a halftoning
method in order to represent millions of colors or the gradation
of colors. This method is shown in the image below.

Dithering and error diffusion are the most commonly used
halftoning methods.

printer

monitor
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Dithering

Dithering uniformly aligns individual dots of different colored
inks to create the appearance of natural colors. This method is
suitable for printing documents that contain large areas of solid
color, such as bar charts and graphs.

Error diffusion

Error diffusion blends individual colored dots with the colors of
the surrounding dots to create the appearance of natural colors.
By blending colored dots, the printer can achieve excellent colors
and subtle color gradation. This method is best suited for printing
documents that contain detailed graphics or photographic
images.

Image Resolution and Image Size

The resolution of your original image affects the quality of your
printouts. Generally, the higher the resolution, the better the print
quality. However, keep in mind that the higher the resolution, the
longer the wait for processing and printing a document.

Generally, the printed image size is in inverse proportion to the
image resolution, as shown below. The larger the image size, the
lower the image resolution. Conversely, the smaller the image
size, the higher the image resolution.

Note:
Some applications have a function that can correct this relationship.
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Print

Print

300 pixel
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300 dpi
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225 pixel

400 pixel
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300 dpi

75 dpi

Print

Print

292 pixel

72 pixel
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Since increasing the image size means decreasing the image
resolution, you must take care that print quality or color tone is
not degraded when working with images pasted into documents
created with word processing software. To avoid print quality
and color tone problems, change the size and the resolution of the
image in your graphics application before pasting it into your
document.

Guidelines for Using Color

To help you use color to maximize your document’s impact on its
readers, determine the who, what, when, where, why, and how
of color printing.

Know WHO your readers are and WHAT your purpose is

Your documents are intended to communicate information,
opinions, or feelings to one or more people and also to get results.
Therefore, first you need to think about who is going to see your
work—will it be a customer, a co-worker, or some other person?
Also you should consider what your purpose is—do you wish to
advise, sell, or propose, or do you have some other purpose?

For example:
A marketing proposal with generous quantities of bright, fluorescent
colors might fail to impress a conservative accounting firm, yet win over
a music video company.

Know WHEN to use color

While color can enhance any document, you need to decide when
color helps expand the reader’s understanding of your message
and when it distracts the reader. Sometimes a serious business
message is best delivered without additional colors. (Remember
that white and black are colors, too.)
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For example:
A job offer letter to a prospective employee works best in black and white,
while a list of safety rules benefits from attention-getting color.

Decide WHERE color will most benefit your document

If you use color on every page or all over a page, you may lose
not only the impact of color, but also the clarity and readability
of your work. When used consistently and strategically, color
breaks up the monotony of black-and-white text reading.

Note:
❏ Avoid placing too many color pictures, tables, or icons on a page.

❏ Size your color images so that they do not overpower text or
graphics.

❏ Avoid using too much colored text. It is more difficult to read than
black-on-white or white-on-black text.

Know WHY you are using color

Color adds interest and clarity, and makes documents appear
easier to understand. Just as you use fonts and graphics to create
appeal and capture attention, color provides an additional visual
interpretation of a document that influences the reader.

For example:
An overhead presentation of sales results by territory is far more
interesting and memorable if you show the figures with colored charts
and graphs.

Know HOW to select colors

Determine a rule for using color throughout the document.
Follow the rules below to make your color document more
appealing and effective.
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❏ Use just one hue in the hue circle to
make your document unified. Modify
saturation or brightness to add interest.

or

❏ Use contrasting hues to make your
work more eye-catching.

❏ Do not use complementary colors in
documents.

Note:
See the Color Guide for details on the hue circle.
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Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed
by the manufacturer at any time, EPSON cannot attest to the quality of
any non-EPSON brand or type of paper. Always test samples of paper
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 48 nozzles

Color (cyan, magenta, yellow light cyan, light
magenta) 240 nozzles
(48 [each color] × 5)

Resolution Maximum 1440 dpi × 720 dpi

Print direction Bidirectional with logic seeking

Control code ESC/P Raster
EPSON Remote

Input buffer 256 KB
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Paper specifications

Single sheets:

Envelopes:

Index cards:

Transparencies, glossy film:

Size A4 (210 mm × 297 mm)
A5 (148 mm × 210 mm)
Letter (216 mm × 279 mm)
Half letter (139.7 mm × 215.9 mm)
Legal (216 mm × 356 mm)
Executive (184.2 mm × 266.7 mm)

Paper types Plain bond paper, special papers distributed by
EPSON

Thickness
(for plain bond paper)

0.08 mm to 0.11 mm (0.003 to 0.004 inch)

Weight
(for plain bond paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Size No. 10 (104.8 mm × 241 mm)
DL (110 mm × 220 mm)
C6 (114 mm × 162 mm)
132 mm × 220 mm

Paper types Plain bond paper, air mail

Thickness 0.16 mm to 0.52 mm (0.006 to 0.02 inch)

Weight 45 g/m² (12 lb) to 75 g/m² (20 lb)

Size A6 (105 mm × 148 mm)
5 × 8” (127 mm × 203 mm)
8 × 10” (203 mm × 254 mm)

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
A6 (105 mm × 148 mm)*

* for glossy film

Paper types Special papers distributed by EPSON
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Self adhesive sheets:

Matte Paper-Heavyweight:

Photo paper:

Premium Glossy Photo Paper:

Photo Stickers:

Note:
❏ Poor quality paper may reduce print quality and cause paper jams

or other problems. If you encounter problems, switch to a higher
grade of paper.

Size A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
100 mm × 150 mm
200 mm × 300 mm
113.6 mm × 175.4 mm
89 mm × 7 M
100 mm × 8 M
210 mm × 10 M

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)

Paper types Special papers distributed by EPSON

Size A6 (105 mm × 148 mm) with 4 or 16 frames

Paper types Special paper distributed by EPSON
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❏ Do not load curled or folded paper.

❏ Use paper under normal conditions:
Temperature 15 to 25°C (59 to 77°F)
Humidity 40 to 60% RH

Printable area

Single sheets (including panoramic size) and index cards

Envelopes

A: The minimum top margin is 3.0 mm (0.12").

When loading multiple sheets of EPSON Photo Quality Glossy
Film, the minimum top margin is 30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12").

A

B-L B-R

C

A

B-L B-R

C
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Note:
Always load paper into the sheet feeder short edge first. Load
envelopes flap edge first with the flap side down.

Ink Cartridges

This ink cartridge for this printer have an IC chip. The IC chip
stores data about the amount of ink remaining and other items,
so that even if an ink cartridge is removed before it is empty, it
can be put back in and used normally.

Black ink cartridges

There are two types of black ink cartridges. The Light Capacity
ink cartridge (T010) contains half of the amount of ink as the
Standard Capacity ink cartridge (T007).

B-R: The minimum right margin is 3.0 mm (0.12").

C: The minimum bottom margin is 14.0 mm (0.55").

✽: You can extend the minimum bottom margin to 3 mm by
selecting Maximum as the Printable Area setting on the
printer driver's Paper menu (for Windows) or in the Page
Setup dialog box (for Macintosh). However, print quality
may decline in the expanded area. Before printing large
jobs using this setting, print a single sheet to confirm printout
quality.

Color Black

Print
capacity*

540 pages (A4, text at 360 dpi) Standard Capacity
(T007)

270 pages (A4, text at 360 dpi) Light Capacity (T010)

Cartridge life 2 years from production date
(within 6 months after opening package, at 25°C [77°F])
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Color ink cartridge (T008)

* The figure given is based upon continuous printing after ink replacement.
The actual print capacity may vary, depending on how often you use the
print head cleaning function and how often you turn the printer on.

** Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

Temperature Storage: -20 to 40°C (-4 to 104°F)
1 month at 40°C (104°F)

Transit: -30 to 60°C (-22 to 140°F)
1 month at 40°C (104°F)
120 hours at 60°C (140°F)

Freezing:** -16°C (3.2°F)

Dimensions 20.1 mm (W) × 60.0 mm (D) × 38.5 mm (H)

Color Cyan, Magenta, Yellow, Light cyan and Light
magenta

Print capacity* 330 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date
(within 6 months of opening the package at 25°C
[77°F])

Temperature Storage: -20 to 40°C (-4 to 104°F)
1 month at 40°C (104°F)

Transit: -30 to 60°C (-22 to 140°F)
1 month at 40°C (104°F)
120 hours at 60°C (140°F)

Freezing:** -18°C (-0.4°F)

Dimensions 49.1 mm (W) × 60.0 mm (D) × 38.5 mm (H)
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c Caution:
❏ EPSON recommends the use of original EPSON ink

cartridges only. Other products not manufactured by
EPSON may cause damage to your printer not covered by
EPSON's warranties.

❏ Do not use an ink cartridge if the date on the package has
expired.

❏ Do not refill the ink cartridge. The printer calculates the
amount of ink remaining using an IC chip on the ink
cartridge, so even if the cartridge is refilled, the IC chip will
report that it is empty.
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Mechanical

Electrical

Note:
Check the label on the back of the printer for the voltage of your printer.

Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity About 100 sheets at 64 g/m² (17 lb) paper

Dimensions Storage
Width: 470 mm (18.5 inches)
Depth: 285 mm (11.2 inches)
Height: 175 mm (7.1 inches)

Printing
Width: 470 mm (18.5 inches)
Depth: 613 mm (24.1 inches)
Height: 302 mm (11.9 inches)

Weight 5.6 kg (12.3 lb) without the ink cartridges

120V Model 220-240V Model

Input voltage range 99 to 132V 198 to 264V

Rated frequency
range

50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18W (ISO10561 Letter Pattern)
Approx. 3.5W in standby mode
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Environmental

* Stored in shipping container

** Without condensation

Safety Approvals

Safety standards:

EMC:

Temperature Operation: 10 to 35°C (50 to 95°F)
Storage: -20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)
Transit:* -20 to 60°C (-4 to 140°F)

120 hours at 60°C (140°F)

Humidity Operation: 20 to 80% RH
Storage:*,** 5 to 85% RH

U.S. model UL 1950
CSA C22.2 No.950

European model Directive 73/23/EEC

EN60950

U.S. model FCC part 15 subpart B class B

European model Directive 89/336 /EEC

EN 55022 (CISPR Pub. 22) class B
EN 50082-1

IEC 801-2
IEC 801-3
IEC 801-4

EN 61000-3-2
EN 61000-3-3

Australian model AS/NZS 3548 class B
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System Requirements

For PCs

To use your printer, you need Microsoft® Windows® 95,
Windows® 98, or Windows® NT 4.0 installed and a shielded,
twisted-pair parallel cable connected. If you want to connect your
printer to a USB port, you need a Windows 98 pre-installed PC
equipped with a USB port and a shielded USB cable connected.

Your computer should also meet the following system
requirements.

Your computer dealer can help you update your system if it does
not meet these requirements.

For Macintosh computers

To connect this printer to Apple® Macintosh® computers, you
must use a USB cable.

Minimum System Requirements Recommended System

i486/25 MHz for Windows 95 and NT 4.0
i486/66 MHz for Windows 98

Pentium or higher processor

16 MB RAM 32 MB RAM or more for
Windows 95 and 98
64 MB or more for Windows
NT 4.0

20 MB hard disk space for Windows 95
and 98
40 MB for Windows NT 4.0

50 MB or more hard disk
space for Windows 95 and
98
100 MB or more for Windows
NT 4.0

VGA monitor VGA or better monitor
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Your Macintosh must also meet the following system
requirements.

Note:
❏ The amount of available memory varies according to the number and

kind of applications that are open. To see how much memory is
available, choose About This Computer from the Apple menu and
refer to the memory size (listed in kilobytes) under “Largest Unused
Block” (1,024K=1 MB).

❏ The memory requirements above are for printing on Letter size
paper. These requirements may vary depending on the size of the
paper, the type of application you are using, and the complexity of
the document you want to print.

In addition to these system and memory requirements, you need
12 MB of free hard disk space to install your printer software. To
print, you also need extra hard disk space amounting to about
twice the size of the file you want to print.

Minimum System Requirements Recommended System

Mac OS 8.1 Mac OS 8.5.1 or later

7 MB RAM
10 MB RAM when background
printing is turned on.

16 MB RAM
27 MB RAM when background
printing is turned on.
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Glossary

The following definitions apply specifically to printers.

application
A software program that helps you carry out a particular task, such as word
processing or financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding
system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs
when the print head is misaligned. See also MicroWeave.

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer
or computer.

brightness
The lightness or darkness of an image.

buffer
The portion of the printer's memory used to store data before printing it.

byte
A unit of information consisting of eight bits.

characters per inch (cpi)
A measure of the size of text characters, sometimes referred to as pitch.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to
create the subtractive system array of printed colors.

color matching
A method of processing color data so that colors displayed on a computer screen
closely match colors in printouts. A variety of color-matching software is
available. See also ColorSync.

ColorSync
Macintosh software that is designed to help you get WYSIWIG (what you see is
what you get) color output. This software prints colors as you see them on your
screen.

cpi
See characters per inch.
Glossary -1



default
A value or setting that takes effect when the equipment is turned on, reset, or
initialized.

dithering
A halftoning method in which dots are arranged in an orderly pattern. Dithering
works best for printing images with solid colors, such as charts and graphs. See
also halftoning.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU
and allows direct communication between a computer and peripheral devices
(like printers), and between one peripheral device and another.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as CD-ROM, hard disk, or floppy disk. In Windows, a
letter is assigned to each drive for easy management.

driver
A software program that sends instructions to a computer peripheral to tell it
what to do. For example, your printer driver accepts print data from your word
processor application and sends instructions to the printer on how to print this
data.

economy printing
Printing in which images are printed with fewer dots to save ink.

error diffusion
Error diffusion blends individual colored dots with the colors of the surrounding
dots to create the appearance of natural colors. By blending colored dots, the
printer can achieve excellent colors and subtle color gradation. This method is
best suited for printing documents that contain detailed graphics or photographic
images.

ESC/P
Abbreviation for EPSON Standard Code for Printers, the system of commands
your computer uses to control your printer. It is standard for all EPSON printers
and is supported by most application software for personal computers.

Finest detail
This printer driver setting automatically makes your printout sharper and
clearer, especially for text. Be aware that this may increase the time required for
printing.

font
A style of type designated by a family name.
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grayscale
A scale of shades of gray from black to white. Grayscale is used to represent colors
when printing with black ink only.

halftones
Patterns of black or colored dots used to reproduce an image.

halftoning
A method of using dot patterns to represent an image. Halftoning makes it
possible to produce varying shades of gray using only black dots, or a nearly
infinite array of colors using only a few colors of dots. See also halftones.

high speed printing
Printing in which images are printed in both directions. This provides faster
printing.

initialization
Returns the printer to its defaults (fixed set of conditions). This happens every
time you turn on the printer or reset the printer.

ink cartridge
Contains the ink your printer uses when printing.

ink jet
A method of printing in which each letter or symbol is formed by precisely
spraying ink onto paper.

interface
The connection between the computer and the printer. A parallel interface
transmits data one character or code at a time. A serial interface transmits data
one bit at a time.

interface cable
The cable that connects the computer and the printer.

local printer
The printer connected to the computer’s port directly by interface cable.

media
Materials upon which data is printed, such as envelopes, plain paper, special
paper, and transparency film.

memory
The part of the printer’s electronic system that is used to store information (data).
Some information is fixed and is used to control how the printer operates.
Information that is sent to the printer from the computer is stored in memory
temporarily. See also RAM and ROM.

MicroWeave
Printing in which images are printed in finer increments to reduce the possibility
of banding and to produce laser-like images. See also banding.
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monochrome
This means printing with only one color of ink, which is generally black ink.

nozzle
Fine tubes in the print head through which ink is sprayed on the page. Print
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer
operation check, the printer prints the ROM version, code page, ink counter code,
and a nozzle check pattern.

parallel interface
See interface.

port
An interface channel through which data is transmitted between devices.

printable area
The area of a page on which the printer can print. It is smaller than the physical
size of the page due to margins.

printer driver
A software program that sends commands for using the features of a particular
printer. Often shortened to “driver”.

print queue
If your printer is connected to a network, print jobs that are sent to the printer
while it is busy are stored in a waiting line, or print queue, until they can be
printed.

RAM
Random Access Memory. The portion of the printer's memory used as a buffer
and for storing user-defined characters. All data stored in RAM is lost when the
printer is turned off.

reset
To return a printer to its defaults by turning the printer off and then back on.

resolution
The number of dots per inch used to represent an image.

ROM
Read Only Memory. A portion of memory that can only be read and cannot be
used for data storage. ROM retains its contents when you turn off the printer.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube
(CRT) monitor's electron gun, are used to create the additive array of screen
colors.
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serial interface
See interface.

spool
The first step in printing, in which the printer driver converts the print data into
codes that your printer understands. This data is then sent directly to the printer
or to the print server.

spool manager
The software program that converts print data into codes that your printer
understands. See also spool.

status monitor
The software program that allows you to check the printer’s status.

subtractive colors
Colors produced by pigments that absorb some colors of light and reflect others.
See also CMYK.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral
devices (such as keyboards, mice, and printers) to the computer through a single,
general-purpose port. The use of USB hubs allows you to add additional ports.
See also interface.

WYSIWIG
What-you-see-is-what-you-get. This term is used to describe printout that looks
exactly like it appears on screen.
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